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caractérnstioues ae votre
nouvead lecteur MP3

Attrayant. Intelligent. Fiable. Et beaucoup de plaisir. Votre nouveau lecteur
MP3 vous offre tout cela et encore plus. Cet apparelil a la fine pointe de la
technologie vous offre un son riche et des images éclatantes de couleur.
Vous adorerez votre nouveau lecteur MP3 ; pendant vos exercices, pour
télécharger votre musique préférée, visionner vos vidéos ou méme pour
écouter la radio FM. Un seul essal, et vous vous demanderez comment

VOUS avez pu vivre sans Iui,

NOUS AVONS AJOUTE LE “MULTI” DANS
MULTIMEDIA

DUREE DE LECTURE PROLONGEE ET DE
TELECHARGEMENTS PLUS COURTS !

Nous I'appelons un lecteur MP3 mais c'est
encore beaucoup plus. Il vous permet de
visionner des photos, des textes, des vidéos

et aussi d’écouter la radio FM. La technologie
sans fil Bluetooth intégrée transforme le lecteur
MP3 en votre réseau personnel.

NAVIGATION TACTILE !

Naviguez dans les menus en touchant
simplement I'écran tactile.

LA OU LA FORME RENCONTRE LA
FONCTIONALITE

Bien sdr, il est mince et harmonieux. Mais il
est aussi facile & tenir et a manipuler.

Une pile pleine charge peut vous offrir
jusgu’a 35 heures de musique ou 5 heures
de vidéo.

La durée de téléchargement est plus courte.
Grace a sa capacité USB 2.0, le lecteur

est beaucoup plus rapide que les modeéles
utilisant la capacité USB 1.1.

UNE MERVEILLE ACOUSTIQUE

Votre nouveau lecteur MP3 posséde I'engin
DNSe™ (Engin de son naturel numérique),
une technologie sonore unique & Samsung
créée pour produire une son plus riche,
plus profond. Il vous offre une expérience
d’écoute inimaginable.




Signification des icones et des symboles contenus
dans ce manuel :

Indique des risques de dommages corporels ou de mort.
AVERTISSEMENT

A Indique un risque potentiel de dommages corporels ou
ATTENTION | Matériels.

Veuillez respecter les consignes de sécurité suivantes
afin de réduire les risques d’incendie, d’explosion,
ATTENTION | @ glectrocutlon ou de dommages corporels lorsque vous
utilisez votre lecteur MP3 :

[Q Indique des conseils ou des pages de référence qui
REMARQUE | pourraient vous aider a utiliser le lecteur.

Ne PAS tenter.

Ne PAS démonter.

Ne PAS toucher.

Suivre explicitement les directives.

Débrancher la fiche d’alimentation de la prise murale.

A®ER O

Appeler le centre de services pour de l'aide.

Ces symboles d'avertissement sont la pour vous protéger contre les
dommages corporels, vous et les autres. Veuillez les respecter a la lettre.
Apres avoir lu cette section, veuillez la conserver pour consultation ultérieure.



Ce manuel décrit le mode d’emploi approprié de votre nouveau
lecteur MP3. Veuillez le lire attentivement afin d'éviter de vous blesser
ou d’endommager le lecteur. Veuillez particulierement respecter les
avertissements sérieux qui suivent :

PROTEGEZ-VOUS

= Ne prenez pas linitiative de démonter, réparer ou modifier cet appareil
vous-méme.

A = Ne mouillez pas I'appareil et ne le laissez pas tomber dans I'eau.
arenion - S le produit devient mouillé, ne I'allumez pas. Cela peut entrainer des
risques d’électrocution. Contactez plutdt le centre de service a la clientéle
Samsung le plus proche.

Evitez d'utiliser le produit pendant les orages. Cela peut provoquer une
risque d’électrocution ou une défaillance de I'appareil.

A N'utilisez pas I'écouteur lorsque vous conduisez une bicyclette, une
arenmon @Utomobile ou une motocyclette.
bicyclette, une automobile ou une motocyclette. Dans le cas contraire, vous
risqueriez de provoquer un accident grave. En outre, son utilisation est interdite par
la loi dans certaines régions.

Utiliser des écouteurs en marchant ou en joggant sur la route et en particulier sur
un passage pour piétons peut entrainer un accident sérieux.

Pour votre sécurité, veillez a ce que le cordon des écouteurs ne
s’emmeéle pas dans vos bras ou dans d’autres objets environnants
pendant vos exercices ou vos marches.

= Ne rangez pas I'appareil dans un endroit humide, poussiéreux ou
wermssaent COUVeErt de suie, sous peine de provoquer un incendie ou une décharge
électrique.



PROTEGEZ-VOUS

= Le port des écouteurs ou d’'un casque d'écoute pendant une période
wemssmer  prolongée peut causer des troubles de I'ouie sérieux.
Une exposition prolongée a un son plus élevé que 85 dB peut avoir un effet négatif
sur votre ouie. Plus le son est élevé, plus le probleme de I'ouie peut étre sérieux
(une conversation ordinaire s’éléve entre 50 et 60 dB et le bruit de la route & environ
80 dB). Nous vous recommandons fortement de régler le volume sur un niveau
moyen (le niveau moyen se situe habituellement aux 2/3 du niveau maximum).

= Si vous entendez un bourdonnement, baissez le volume ou cessez
I'utilisation des écouteurs ou du casque.

PROTEGEZ VOTRE LECTEUR MP3

= Ne rangez pas I'appareil dans un lieu ou la température excede 35° C
(95° F) (comme dans un sauna ou une voiture en stationnement par
exemple).
= Evitez tout impact brutal sur 'appareil (ex. : en cas de chute).
= Ne posez pas d'objets lourds sur le lecteur.
= Empéchez que des particules externes ou de la poussiére ne pénétrent
dans I'appareil.
= Ne placez pas le produit prés d'un objet a propriétés magnétiques.
= Veillez a toujours enregistrer vos données les plus importantes.
Samsung dénie toute responsabilité pour les pertes de données.
= Utilisez toujours les accessoires fournis ou agréés par Samsung.
= Evitez toute projection d’eau sur I'appareil. Ne nettoyez jamais I'appareil
arention @ I'aide de produits chimiques (ex. : benzene ou diluant) sous peine de
provoquer un incendie, une décharge électrique ou une détérioration de
la surface.
= Suivez attentivement ces instructions sous peine de provoquer des
arrention - dommages corporels ou d'endommager I'appareil.
= Si vous souhaitez imprimer ce manuel, nous vous recommandons de
revarque  |'imprimer en couleur et de cocher 'option d’imprimante « Ajuster a la
page » pour une meilleure lecture.




fable des matieres
PRINCIPES 10 Articles compris
FONDAMENTAUX 11 \Votrelecteur MP3

14 Ecrans d'affichage

17 Utilisation des touches

18 Chargement de la pile

19 Entretien de la pile

19 Mise sous et hors tension de
I'appareil

20 Lecture de pieces musicales

20 Contréle du volume

21 Désactivation des touches

21 Naviguer dans les fichiers al'aide du
“Dossier Navigateur”

22  Supprimer des fichiers a I'aide du
“Dossier Navigateur”

23 Modification des réglages et de vos

préférences
23 Réglages du style du menu
24 Réglages du son
25 Parametres de I'écran
26 Réglages de la langue
27 Parametres Date et heure
28 Parametres du systeme

31 Réinitialiser le systéeme
SAMSUNG MEDIA STUDIO 32 Besoins de I'ordinateur

33 Installation de Samsung Media Studio

34 Répartition des dossiers et des
fichiers a I'aide de Samsung Media
Studio



faole des materes
ECOUTE DE LA 37 Ecoute par catégorie
MUS|QUE 38 Pause
3

8 Recherche sur une piste
38 Lecture de la piste en cours a partir
du début
38 pour écouter la piste précédente
38 Lecture de la plage suivante
39 Pour créer une liste de lecture a I'aide
de Média Studio de Samsung
39 Comment créer une liste de lecture
40 Comment ajouter des fichiers
musicaux sur une liste de lecture que
vous avez créée
41 Exporter une liste de lecture vers
votre lecteur a l'aide de Média Studio
42 Pour créer une liste de lecture sur
votre lecteur mp3
43 Lecture d’une liste de lecture
44 Pour supprimer un fichier de la liste
de lecture
44 Pour supprimer tous les fichiers de la
liste de lecture
45 Pour utiliser le menu musique

POUR VISIONNER 52 Pourinterrompre le visionnement en cours
UNE VIDEO 53 Pourvous déplacer sur une image
spécifique
53  Pour visionner le fichier vidéo précédent
53 Lirele fichier video suivant
54  Pour utiliser le menu vidéo



faple des matlieres
POUR VISIONNER 57 Pour visionner des photos
DES PHOTOS 58 Pour utiliser le menu photo

ECOUTE DE LA 62 Pour utiliser la fonction Mute (Muet)
RADIO FM 63 Recherche de stations FM
64  Pour utiliser le menu radio fm

POUR UTILISER 71 Pour enregistrer une chaine
LA DIEFUSION 72 Pourcréer une nouveau groupe de
z chaines
DE DONNEES 72  Pour transférer une diffusion de
données de <Media Studio>
73  Visualisation des diffusions de données

POUR PROFITER 74 Lecture du texte
DE L'OFFRE 75 Pour utiliser le menu texte

Enregi strement vocal
PRIME PACK 82 Jeux vidéo

84  Visualisation du carnet d’adresses
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ARTICLES COMPRIS

Votre nouveau lecteur MP3 vous parvient accompagné des accessoires
suivants. Si certains de ces articles sont manquants, contactez le centre de
service a la clientéle de Samsung.

s A @

< @ >

Lecteur Ecouteurs

Cable USB CD d’installation

L'aspect des accessoires est susceptible d’étre amélioré et modifié, sans
notification préalable.
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VOTRE LECTEUR MP3

/-ﬁ | Affichage a I'écran
//f 1

Interrupteur Power (Alimentation)

et Hold (Maintien) o (Tw= 7/
Faites glisser le curseur dans le sens
opposé a la fleche et retenez-le pour
\ allumer/éteindre I'appareil.
Déplacez-le dans la direction de la

fleche pour verrouiller les fonctions
des touches.

d
>
@
T3

L

Trou de réinitialisation —/

Si une défaillance se produit,
appuyez sur le bouton de
réinitialisation a l'aide d’un objet
pointu pour réinitialiser le systéme. principes fondamentaux _ 11



VOTRE LECTEUR MP3 (Suite)

Ce sont les « Touches ».

B Touche Menu
Tapez sur la touche pour afficher I'écran de menu.

~ Touche d’augmentation du volume
Tapez sur la touche pour augmenter le volume sonore
ou pour vous déplacer sur un élément/menu supérieur.

“DTouche de retour en arriére

Tapez sur la touche pour vous déplacer vers
I’écran précédent.

Appuyez sur la touche pendant un court moment
pour vous déplacer vers le menu principal.

{ Fléche de gauche du navigateur de fichiers
Tapez sur la touche pour sélectionner la piste ou
le menu précédent ou pour lire la piste en cours a
partir du début.

Appuyez sur la touche pendant un court moment
pour balayer rapidement les pistes.

@ Touche Lecture/Pause et Sélectionner
Tapez sur la touche pour sélectionner lecture/pause et la
fonction, ou pour vous déplacer vers I'écran suivant.

v Touche de diminution du volume
Tapez sur la touche pour diminuer le volume sonore
ou pour vous déplacer sur un élément/menu inférieur.

> Fleche de droite du navigateur de fichiers

Tapez sur la touche pour vous déplacer sur la piste ou
sur le menu suivant. Appuyez sur la touche pendant un
court moment pour balayer rapidement les pistes.

12 _ principes fondamentaux
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VOTRE LECTEUR MP3 (Suite)

— Prise de branchement des
écouteurs

Trou de la cordelette

Port USB Ecouteurs
lls sont marqués d'un « L »
Microphone pour I'écouteur de gauche

et d'un « R » pour I'écouteur
de droite. lls servent aussi
d’antenne FM pour le lecteur
MP3.

principes fondamentaux _ 13



ECRANS D’AFFICHAGE

Musique

B

Bluetooth/témoin de verrouillage

)

Témoin du menu parent

Etat de la pile

Piste présentement en lecture /
témoin du nombre de pistes

Témoin de vitesse de lecture

L’heure actuelle

Durée totale de la lecture

- Friil

Témoin du lecture/pause,
recherche

Témoin du mode Musique

Témoin du mode lecture

Témoin du mode DNSe

Etat de la lecture de musique

Barre d’état de la lecture

Durée actuelle de la lecture

Titre de la musique

FEEEREEEE BEE EEE]

fg = Les représentations a I'écran figurent a titre indicatif uniquement. L'écran réel de
revamque  VOtre appareil peut étre différent.
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ECRANS D'AFFICHAGE (Suite)
Video

Bluetooth/témoin de verrouillage Témoin du mode vidéo

Etat de la pile Nom du fichier

L’heure actuelle Barre d'état de la lecture

@& )

Durée totale de la lecture Durée actuelle de la lecture

Témoin de lecture/pause, recherche

principes fondamentaux _ 15



ECRANS D’'AFFICHAGE (Suite)

Photo

Bluetooth/témoin de verrouillage

Etat de la pile

| Picture Imagel.jpg

Témoin Fichier actuel / Nombre
total de fichiers

e 8

L’heure actuelle

i

Etat de la lecture de musique

Témoin du mode Photo

Témoin du menu parent

CEHEEHEE EE)

Nom du fichier

[Ecran de visionnement de photos]

Radio FM

Bluetooth/témoin de verrouillage

(-]

Etat de la pile

04:29 PM i~

L’heure actuelle

Témoin du mode Radio

—— MANUAL

——91.9wH:

Témoin manuel/préprogrammé

Témoin de la fréquence actuelle
(MHz)

5o
&) @EHEEE
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UTILISATION DES TOUCHES

Tapez I'écran tactile du bout des doigts.

oo

’Q = Pour éviter d'endommager I'écran tactile, évitez d'utiliser un objet autre que vos
remaroue  dOigts pour le manipuler.
= Ne tapez pas I'écran tactile avec des doigts sales.
= Ne tapez pas I'écran tactile avec des gants.
= |l peut mal fonctionner si vous utilisez vos ongles ou un autre objet comme un stylo
a bille.

principes fondamentaux _ 17



CHARGEMENT DE LA PILE

Chargez-la avant d'utiliser votre lecteur pour la premiére fois et lorsqu’il n'a pas
été utilisé pour une période prolongée.

Charger la pile de votre lecteur MP3 prend environ 3 heures ; la durée totale du
chargement peut varier en fonction des conditions de votre ordinateur.

= Avant de démarrer - Débrancher les écouteurs avant de brancher le cable USB.

Affichage a I’écran
= Branché USB
= Sous charge...
= Pleine charge

1. Branchez la grande fiche du cable USB sur la prise du port USB située sur le
dessous du lecteur.

2. Branchez le cable USB sur le port USB (+<<*) de votre ordinateur.

18 _ principes fondamentaux



ENTRETIEN DE LA PILE

Suivre ces simples conseils d’entretien et de rangement prolongera la durée de
votre pile.

* Rechargez et rangez 'appareil dans un lieu ou la température est comprise
entre 5°C et 35°C.

« Evitez de surcharger la batterie (12 heures au maximum). Charger ou
décharger la batterie a des fréquences trop rapprochées peut réduire sa
durée de vie.

« Comme pour tout autre produit de consommation, la durée de vie de la
batterie raccourcit progressivement avec le temps.

/| = Sivous chargez le lecteur pendant qu'il est branché sur un ordinateur portable,
veillez a ce que la pile du portable soit aussi complétement chargée ou qu'il soit

REMARQUE “ g >
branché sur une source d'alimentation.

MISE SOUS ET HORS TENSION DE L’APPAREIL

Mise sous tension de I'appareil

Faites glisser le commutateur © sdans le sens
opposé a la fleche et retenez-le.

= L'appareil s'allume

Mise hors tension de I'appareil

Faites glisser a nouveau le commutateur ®
dans le sens opposé a la fleche et retenez-le.

= Le lecteur s'éteint.

= Votre lecteur MP3 s’éteindra automatiquement si aucune des touches n’est
revarque  actionnée pendant une période spécifigue en mode pause. Le réglage a l'usine
de la fonction <Auto Power Off> (Mise hors tension automatique) est de 1 minute ;
vous pouvez cependant en modifier la durée. Reportez-vous a la page 29 pour plus de
détails.
principes fondamentaux _ 19



LECTURE DE PIECES MUSICALES

Téléchargez les fichiers musicaux sur votre nouveau lecteur MP3 a I'aide de
Samsung Media Studio. Pour en savoir plus a propos de Samsung Media

Studio, Reportez-vous a la page 34.

1. Appuyez sur [ 2] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Music> (Musique),
puis tapez sur [@].

3. Utilisez [~ ~] et [@] pour sélectionner le fichier musical
souhaité.

4. Tapez sur [@].
= La lecture du fichier musical est lancée.

[.g = Tapez sur [*D] pour vous déplacer vers I'écran précédent.

REMARQUE N .
principal.

CONTROLE DU VOLUME

04:29 PM (il

Appuyez sur [*D] pendant un court moment pour vous déplacer vers le menu

Tapez sur [@].
= Licéne du contréle de volume s’affiche.
= Le réglage de la dynamique se situe entre 0 et 30.

= Tapez sur [~ ] pour augmenter le volume ou sur [~] pour le
diminuer.

20 _ principes fondamentaux
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DESACTIVATION DES TOUCHES

La fonction de verrouillage désactive toutes les autres touches du lecteur MP3.
Ainsi, si vous en tapez une par accident pendant vos exercices par exemple,
votre musique ne s’arrétera pas.

1. Faites glisser le commutateur \T—#sier 7/ dans le sens
de la fleche.

2. Faites glisser le commutateur \ stz / dans le sens
opposé a celui indiqué par la fleche pour désactiver la
fonction Lock (Verrouillage).

Sweetbox
Life is cool

NAVIGUER DANS LES FICHIERS A
L’AIDE DU “DOSSIER NAVIGATEUR”

Recherchez des fichiers en toute simplicité grace la fonction <File Browser>
(Dossier Navigateur).
1. Appuyez sur [ *2] pendant un court moment pour vous
déplacer vers le menu principal.
2. Tapez sur [< >] pour sélectionner <File Browser>
(Dossier Navigateur), puis tapez sur [@].
= Le dossier <File Browser> (Dossier Navigateur) contenant
des fichiers musicaux, des listes de lecture, des vidéos, des
images, des listes de diffusion, des textes, des jeux, des fichiers
enregistrés et des fichiers regus apparait.
3. Tapez sur [~ ] pour sélectionner un dossier.
4. Tapez sur [@] pour afficher la liste de fichiers contenus
dans le dossier.
= Tapez sur [*D] pour vous déplacer vers I'écran précédent.
5. Tapez sur [~ ~] pour sélectionner un fichier.
. Tapez sur [@].
= La lecture du fichier débute.

[e2)
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SUPPRIMER DES FICHIERS A L’'AIDE DU “DOSSIER
NAVIGATEUR”

1. Appuyez longuement sur [*©] pendant un court moment  [ENET cerE
pour vous déplacer vers le menu principal. T 3

2. Tapez sur [< >] pour sélectionner <File Browser> M Playiists
(Dossier Navigateur), puis tapez sur [@]. M Video
= La liste de dossiers du <File Browser> (Dossier Navigateur) : m
s'affiche. N i
2 . . s M Games
3. Tapez sur [~ ] pour sélectionner le dossier souhaite, , Recorded Fies
puis tapez sur [@]. | Received Fi

4. Tapez sur [~ ~] pour sélectionner le fichier a supprimer,
puis tapez sur [B].

5. Tapez sur [~ ] pour sélectionner <Delete> (Supprimer), puis tapez sur [@].
= La fenétre de confirmation apparait.

6. Tapez sur [ >] sélectionner <Yes> (Oui), puis tapez sur [@].
= Le fichier est supprimé.

A = Les fichiers ne peuvent pas étre récupérés une fois supprimés.

ATTENTION
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MODIFICATION DES REGLAGES ET DE VOS PREFERENCES
Votre lecteur MP3 comprend des réglages et des préférences définis par défaut,
mais vous pouvez les modifier selon votre godt afin de personnaliser votre lecteur.
rg = Tapez sur [*D] pour vous déplacer vers I'écran précédent.

Appuyez sur [*D] pendant un court moment pour vous déplacer vers le menu principal.

Réglage du style de menu
Vous pouvez modifier les polices et le modele du menu et supprimer le
fond d'image du menu principal.

REMARQUE

1. Appuyez sur [*9] pendant un court moment pour : o i
vous déplacer vers le menu principal. N
2. Tapez sur [ >] pour sélectionner <Settings> S'Y'e <3
(Parametres), puis tapez sur [@]. &
= Le menu <Settings> (Parametres) apparait. il
- . - Date & Time
3. Tapez sur [~ ] pour sélectionner <Menu Style> [ sysem
(Style du menu), puis tapez sur [@].
= Le menu <Menu Style> (Style du menu) apparait. 25

4. Réglez ces fonctions a l'aide des touches [~ v] et [@].
= Tapez sur [@] pour passer a I'élément/menu suivant.
= Tapez sur [~ ] pour défiler sur le menu affiché.

Options de réglage du style de menu

= Menu Design (Modele de menu) : Pour modifier le style d’écran du menu principal.
Sélectionnez parmi <Sammy>, <Pendant> (Pendentif) et <My Skin> (Mon habillage).

= Color Tone (Couleur) : Vous permet de définir la couleur des menus et celle du fond
d’écran. Si vous définissez <Sammy> sous <Menu Design> (Aspect du menu), <Color
Tone> (Couleur) sera désactivé.

= Font (Polices) : Pour modifier la police de la langue des menus. Sélectionnez parmi 3
polices. Certaines langues de menu n’affichent pas <Font> (Polices).

= Reset My Skin (Recomposer mon habillage) : Pour recomposer le fond d’image de
I'écran tactile a sa valeur par défaut. Si vous définissez <Sammy> ou <Pendant>
(Pendentif) sous <Menu Design> (Aspect du menu), <Reset My Skin> (Réinitialiser mon

habillage) sera désactivé.
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MODIFICATION DES REGLAGES ET DE VOS PREFERENCES (Suite)

Parameétres du son

Vous pouvez régler I'égaliseur principal, le signal sonore et I'intensité du
volume sonore.

04:29 PM )
1. Appuyez sur [ 9] pendant un court moment pour |{&
vous déplacer vers le menu principal. “Menu Style

2. Tapez sur [< >] pour sélectionner <Settings>
(Parameétres), puis tapez sur [@].
= Le menu <Settings> (Parameétres) apparait.

3. Tapez sur [~ ] pour sélectionner <Sound>
(Son), puis tapez sur [@].
= Le menu <Sound> (Son) apparait.

4. Réglez ces fonctions a I'aide des touches [~ ] et [@].

Display:

Language
~Date & Time
~ System

Options de réglage du son

Master EQ (Egaliseur maitre (EQ)) : Pour optimiser les paramétres sonores.
Tapez sur [< >] pour sélectionner la fréquence souhaitée. Tapez sur [~ V]
pour régler le niveau de la fréquence sélectionnée, puis tapez sur [@].

Beep Sound (Bip sonore) : Permet d’activer ou de désactiver I'émission d'un
signal sonore lors des opérations effectuées sur I'écran tactile. Choisissez entre
<Off> (Arrét) et <On> (Marche). Durant la lecture d'un fichier musical, le bip
sera désactivé méme s'il est réglé a <On> (Marche).

Volume Limit (Limite du volume sonore) : Permet d’éviter les problémes de
I'ouie en réglant la limite du volume sonore lorsque vous utilisez les écouteurs.
<On> (Activée) limite le volume sonore a un niveau maximum del5. Le niveau
maximum du volume est de 30 lorsque la fonction de limite est sur <Off>
(Désactivée). Afin d'éviter les troubles de I'ouie, le niveau du volume revient sur
15 lorsque vous rallumez le lecteur méme si vous aviez désactivé la limite <Off>
(Désactivée).
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MODIFICATION DES REGLAGES ET DE VOS PREFERENCES (Suite)

Parameétres de I’écran

Permet de modifier la période avant I'extinction et la luminosité de votre écran.

1. Appuyez sur [ ] pendant un court moment pour
vous déplacer vers le menu principal.

. Sound
Display
Language

-Date & Time

~System

2. Tapez sur [< >] pour sélectionner <Settings>
(Parametres), puis tapez sur [@].

= Le menu <Settings> (Parametres) apparait.

!

3. Tapez sur [~ ] pour sélectionner <Display>
(Afficher), puis tapez sur [@].
= Le menu <Display> (Afficher) apparatit.

4. Réglez ces fonctions a I'aide des touches [~ ] et [@].

Options de réglage de I'écran

= Display Off (Ecran éteint) : Si aucune touche n’est activée durant les périodes
indiquées plus bas, I'écran s’éteint automatiguement. Vous pouvez choisir entre
<15 sec>, <30 sec>, <1 min>, <3 min>, <5 min>, et <Always On> (Toujours
activé). Appuyez sur n'importe quelle touche pour rallumer I'écran.

= Brightness (Luminosité) : Vous pouvez régler la luminosité de I'écran.
Sélectionnez un niveau entre <0 et 10>, 10 étant le plus lumineux.
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MODIFICATION DES REGLAGES ET DE VOS PREFERENCES (Suite)

Parameétres de la langue

Les menus de votre nouveau lecteur MP3 peuvent étre réglés de fagon
a apparaitre dans plusieurs langues. Il est trés facile de changer la
langue selon votre choix.

1. Appuyez sur [ ] pendant un court moment pour
vous déplacer vers le menu principal.

04:29 PM
=

N —
| Menu Style
_ Sound

2. Tapez sur [< >] pour sélectionner <Settings>

(Paramétres), puis tapez sur [@].

= Le menu <Settings> (Parametres) apparait. Date & Time
| . _ System
3. Tapez sur [~ ] pour sélectionner <Language>
(Langue), puis tapez sur [@].
= Le menu <Language> (Langue) apparait.
= <English>, <&t= 01>, <Francais>, <Deutsch>, <ltaliano>, <00 0 [J >,
<fEkH 3>, <EREP 3>, <Espafiol>, <Pycckuii>, <Magyar>, <Nederlands>,
<Polski>, <Portugués>, <Svenska>, <'lne>, <Cestina>, <EAAnvikda>,
<Ttirkce>, <Norsk>, <Dansk>, <Suomi>, <Espafiol (Sudamérica)>,
<Portugués (Brasil)>, <Indonesia>, <Tiéng Viét>, <Bulgarian>, <Romana>,
<YkpaiHcbka>, <Slovens¢ina>, <Slovensky>.

4. Tapez sur [~ ~] pour sélectionner la langue, ensuite tapez sur [@].

fg = Les langues prises en charge peuvent étre modifiées ou ajoutées.
REMARQUE
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MODIFICATION DES REGLAGES ET DE VOS PREFERENCES (Suite)

Parameétres Date et heure

Cette fonction vous permet de régler I'heure et la date actuelles.

1. Appuyez sur [ ] pendant un court moment pour
vous déplacer vers le menu principal.

. oazepm@m
s

| Menu Style

2. Tapez sur [< >] pour sélectionner <Settings> - Sound
(Parametres), puis tapez sur [@]. Display
Language

= Le menu <Settings> (Parametres) apparait.

3. Tapez sur [~ ] pour sélectionner <Date&Time>
(Date et heure), puis tapez sur [@].
= Le menu <Date&Time> (Date et heure) apparait.

4. Tapez sur [< >] pour vous déplacer entre <Year, Month, Date, Hour,
Min, AM/PM> (Année, Mois, Date, Heure, Minutes, AM/PM), ensuite
tapez sur [~ ] pour régler chaque élément.

5. Tapez sur [@].

6. Tapez sur [< >] pour sélectionner <Yes> (Oui), puis tapez sur [@].
= Le réglage de I'heure est terminé.
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MODIFICATION DES REGLAGES ET DE VOS PREFERENCES (Suite)

Parameétres du systeme

Choisissez les réglages par défaut qui vous conviennent pour les
fonctions alarme, mode de mise en marche et de mise hors tension
automatique.

1. Appuyez sur [ ] pendant un court moment pour
vous déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Settings>

(Parametres), puis tapez sur [@]. | Display
= Le menu <Settings> (Parameétres) apparait. :;:T:;‘aﬁne

3. Tapez sur [~ ~] pour sélectionner <System> System 5
(Systeme), puis tapez sur [@]. @

* Le menu <System> (Systeme) apparait.

4. Réglez ces fonctions a I'aide des touches [~ ] et [@].
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MODIFICATION DES REGLAGES ET DE VOS PREFERENCES (Suite)

Options de réglage du systeme

= My Profile (Mon profil) : Vous pouvez enregistrer votre nom et votre date de
naissance. Reportez-vous a la page 30.

Sleep (Alarme) : Permet d’éteindre automatiquement I'appareil apres
I'écoulement de la durée présélectionnée. Choix disponibles : <Off> (Arrét),
<15 min >, <30 min>, <60 min>, <90 min> ou <120 min>.

Start Mode (Mode de mise en marche) : Permet de choisir le mode a afficher
a l'allumage du lecteur. Sélectionnez parmi <Main Menu> (Menu Principal) et
<Last State> (Dernier état). Sélectionnez <Main Menu> (Menu Principal) pour
démarrer le systeme en affichant le menu principal et <Last State> (Dernier
état) pour afficher le denier menu utilisé.

Auto Power Off (Mise hors tension automatique) : Permet d'éteindre
automatiquement I'appareil lorsque aucune touche n’est actionnée avant
I'écoulement de la durée présélectionnée en mode Pause. Sélectionnez parmi :
<15 sec>, <30 sec>, <1 min>, <3 min>, <5 min> et <Always On> (Toujours allumé).
Default Set (Réglages par défaut) : Permet de revenir aux valeurs de réglage
par défaut. Options disponibles : <Yes> (Oui) ou <No> (Non). <Yes> (Oui)
permet d'initialiser tous les réglages par défaut. <No> (Non) permet d’annuler
les réglages par défaut.

Format (Formatage) : Permet de formater la mémoire interne. Options
disponibles : <Yes> (Oui) ou <No> (Non). <Yes> (Oui) formate la mémoire
interne et supprime tous les fichiers du lecteur. <No> (Non) prévient le form
Verifiez avant de formater.

About (A propos de) : Pour vérifier la version du micrologiciel, la capacité de
mémoire et le numéro de fichier, tapez [¢ )].

<Firmware Version> (Version du firmware)-affiche la version de micrologiciel
courante.

<Memory> (Mémoire) - <Used> (Utilisée) indique I'usage, <Available>
(Disponible) indique la capacité restante et <Total> (Totale) indique la capacité
totale de la mémoire.

<Files> (Fichiers) - Permet de vérifier le nombre de fichiers musicaux, de vidéos,
de photos, de textes et le nomber total de fichiers.

= A propos de la mémoire intégrée
remamoue 1 GO = 1.000.000.000 d'octets : la capacité formatée réelle peut étre
inférieure puisque le micrologiciel utilise une partie de la mémoire.
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MODIFICATION DES REGLAGES ET DE VOS PREFERENCES (Suite)

Configuration de Mon nom

1. Tapez sur [~ ~] pour sélectionner <My Profile>
(Mon profil), puis tapez sur [@].
2. Tapez sur [~ ] pour sélectionner <My Name>
(Mon nom), puis tapez sur [@].
= La fenétre <Rename My Name> (Renom. Mon nom) apparait.
3. Utilisez [~ ~ ¢ >] et [@] pour renommer le
périphérique.
= [@]: Le mode d’entrée bascule des numéros aux 2
majuscules anglaises et aux minuscules anglaises. =
= [[=]1 : Vous pouvez supprimer les caractéres un par un.
= [[ oK ]] : Vous pouvez ajouter un espace entre les caractéres.
= Aprés avoir configuré votre nom, il apparait a la mise en marche ou a I'arrét
du lecteur.

Configuration de Ma date de naissance

S It =

= Avant de démarrer - En premier lieu, réglez I'horloge a I'heure actuelle.
Voir page 27.
1. Tapez sur [~ ~] pour sélectionner <My Profile>
(Mon profil), puis tapez sur [@].
2. Tapez sur [~ ] pour sélectionner <My Birthday>
(Mon anniv.), puis tapez sur [@].
= La fenétre <Edit My Birthday> (Editer Mon anniv) apparait.
3. Déplacez-vous sur <Year, Month, Date> (Année,
Mois, Date) en touchant [ ¢ »] puis tapez
[~ ~~] pour régler chaque élément. =E
4. Tapez sur [@]. Blar o ol
= La configuration terminée, le lecteur vous rappelle
votre date de naissance & la mise en marche.

Year Month Date

(2o07] (1 )1 ]
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REINITIALISER LE SYSTEME

lIs sera possiblement nécessaire de réinitialiser le systeme s'il devient
impossible d’allumer votre lecteur MP3, s'il ne lit pas la musique ou s’il n’est pas
reconnu par votre ordinateur lorsque vous le branchez.

Appuyez sur la touche Reset situé sur la
partie inférieure de I'appareil a I'aide d’un
objet pointu, comme une un trombone.

= Le systeme est réinitialisé.

= Cela n'affecte pas vos réglages ou vos fichiers.
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. .

Samsung Media Studio est une application logicielle conviviale qui

vous aide a répartir les fichiers de votre ordinateur. Apres avoir trig et
réparti vos fichiers a 'aide de Media Studio, vous pouvez les transférer
rapidement vers votre lecteur MP3 sans avoir a effectuer une recherche
compléte de votre disque dur pour trouver le bon fichier.

BESOINS DE L’ORDINATEUR

Votre systeme d’ordinateur doit posséder les caractéristiques minimales qui
suivent afin de pouvoir installer et exécuter Media Studio :

¢ Pentium 500 MHz ou plus

e Port USB 2.0

* Windows XP Service Pack 2 ou ultérieur
« DirectX 9.0 ou version ultérieure

+ 100 Mo d’espace libre sur le disque dur

¢ Lecteur de CD-Rom (2X ou plus)

« Windows Media Player 10,0 ou ultérieur
« Résolution 1024 X 768 ou plus

¢ Internet Explorer 6.0 ou ultérieur

¢ 512 Mo de mémoire vive ou plus
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INSTALLATION DE SAMSUNG MEDIA STUDIO

A = Veillez a exécuter le programme d’installation de <Media Studio> dans le compte

aennon @dministrateur de votre ordinateur. Autrement, il vous sera impossible d'installer
<Media Studio>. Reportez-vous au mode d’emploi de votre ordinateur pour trouver
le compte administrateur.

1. Insérez le CD d'installation fourni avec le )
lecteur dans le lecteur de CD-ROM de votre s“m }
ordinateur.

[+ it now |
% Exit
2. Cliquez sur <Install now> (Installer . J—

maintenant).
= Suivez les instructions pour lancer l'installation.

= Linstallation de <Media Studio> est lancée et crée I'icone (& sur votre poste de travail
a la fin de l'installation.

= Soyez prudent lorsque vous insérez le CD d'installation dans un lecteur CD-ROM a
amenmon 12 verticale.
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REPARTITION DES DOSSIERS ET DES FICHIERS A
L’AIDE DE SAMSUNG MEDIA STUDIO

Media Studio vous permet de sélectionner et de répartir vos fichiers et dossiers en
prévision d’'un transfert vers votre lecteur. Cela facilite et accélére la recherche de
fichiers sur votre lecteur MP3. Le logiciel <Media Studio> est la méthode la plus
facile d'effectuer un transfert de fichier de votre ordinateur sur votre lecteur MP3.

= Avant de démarrer - Débrancher les écouteurs avant de brancher le cable USB.

1. Branchez la grande fiche du cable USB sur la prise du port USB située sur le
dessous du lecteur.

2. Branchez le cable USB sur le port USB (+<<*) de votre ordinateur.
= <USB connected> (Connexion USB) apparait a I'écran tactile du lecteur.
= <Media Studio> démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.
= Si le programme ne démarre pas automatiquement, double-cliquez sur l'icone &
Media Studio du bureau.

rg = La technologie de reconnaissance musicale et les données relatives sont fournies
par Gracenote et Gracenote CDDB® Music Recognition ServiceS™.

= CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote,
le logo et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB»
sont des marques déposées de Gracenote. Music Recognition Service et MRS sont
des marques de service de Gracenote.

REMARQUE
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REPARTITION DES DOSSIERS ET DES FICHIERS A

L’AIDE DE SAMSUNG MEDIA STUDIO (Suite)

3. Cliquez sur I'icéne du type de fichier que vous |

souhaiter transférer.

= Cliquez sur [ & | pour afficher la liste musicale.

= Cliquez sur = & pour afficher la liste des fichiers
vidéo.

= Cliquez sur | @ | pour afficher la liste de photos

= Cliquez sur ==/ pour afficher la liste de etc. La
liste ETC comprend les autres types de fichier
(ex. : TXT, etc.) sauf les fichiers musique, photo
et vidéo.

4. Cliquez sur <Add File> (Ajouter un fichier) au

bas de I'écran de <Media Studio>.
= La fenétre <Open> (Ouvert) apparait.

5. Sélectionnez les fichiers que vous souhaitez
ajouter et cliquez sur <Open> (Ouvrir).

= Les fichiers sélectionnés sont ajoutés sur la liste a

gauche de 'écran de <Media Studio>.

6. Sélectionnez le fichier a transférer sur la liste
de gauche.

7. Cliquez sur I'icone &b
= Le fichier sélectionné est transféré vers le lecteur.

;000

4 Add File ]
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REPARTITION DES DOSSIERS ET DES FICHIERS A
L’AIDE DE SAMSUNG MEDIA STUDIO (Suite)

ATVATTENTION

REMARQUE

= Ne débranchez jamais le cable USB durant le transfert de fichiers. Le débrancher
durant le transfert peut endommager le lecteur ou votre ordinateur.

= Pour éviter les connexions instables, branchez le lecteur directement sur votre
ordinateur plutdt que par le biais d’un répéteur multiport USB.

= Avant le transfert du fichier vidéo vers le lecteur a l'aide de la fonction <Media
Studio>, le fichier est tout d’abord converti automatiquement au format .svi. La taille
du fichier est également réglée automatiqguement.

Lorsque vous transférez une photo sur le lecteur a l'aide de <Media Studio>, elle
est automatiqguement convertie au format JPG avant son transfert. La taille du
fichier est aussi ajustée.

Une photo transférée sur le lecteur par un autre logiciel que <Media Studio> peut
paraitre différente de I'originale.

Toutes les fonctions sont désactivées durant le branchement.

Si vous branchez le cable USB sur le lecteur alors que la pile est faible, le lecteur
sera mis sous charge pendant plusieurs minutes avant d'établir sa connexion avec
I'ordinateur.

Samsung Media Studio comprend une fonction d’aide approfondie. Si vous ne
pouvez trouver réponse a votre question a propos de Media Studio, cliquez sur
<MENU> (MENU) — <Help> (Aide) —<Help> (Aide) au haut du programme
<Media Studio>.

Qu’est-ce que SVI ?

Samsung Audio Video interleaving (SVI) (Entrelacement audio-vidéo de Samsung)
est un nouveau format vidéo développé et contrdlé par Samsung.
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= Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.
= Tapez sur [*D] pour vous déplacer vers I'écran précédent.

rewamoue  APPUYEZ sur [*2] pendant un court moment pour vous déplacer vers le menu principal.

ECOUTE PAR CATEGORIE

1. Appuyez sur [ *2] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Music> (Musique),

04:29 PM {iiii]

Now Playing ),

puis tapez sur [@]. ﬁ[ﬂiis
= Le menu <Music> (musique) apparaTt. - . i
3. Tapez sur [~ ] pour sélectionner la liste souhaitée, Genres
ensuite tapez sur [@]. ,:ayhs;sd 9
. . . Y ecorae les
Le fichier musical apparal’t. _ o - e
4. Tapez sur [~ ~] pour sélectionner le fichier musical, 5o o]

ensuite tapez sur [@].
= La lecture de la musique démarre.

Liste de fichiers musicaux

Les renseignements reliés au fichier incluant le nom de I'artiste, le nom de I'album, le titre de la
piéce musicale et son genre s'affichent en fonction de I'étiquette ID3 du fichier musical approprié.
Un fichier sans étiquette ID3 s'affiche comme [unknown] (inconnu).

Now Playing (En lecture) : Lit un fichier récemment lu ou se déplace sur I'écran de lecture du fichier actuel.

Artists (Artistes) : lecture par artiste Albums (Albums) : lecture par album
Songs (Chansons) : lecture en ordre numérique ou alphabétique
Genres (Genres) : lecture par genre Playlists (Listes de lecture) : lecture par liste

Recorded Files (Fichiers enregistrés) : Affiche les fichiers enregistrés.
Music Browser (Navigateur de musique) : permet d'afficher tous les fichiers musicaux enregistrés dans le dossier musical.

rg = Les fichiers musicaux MP3, WMA et AAC sont compatibles avec votre lecteur.
= Les fichiers MP1 ou MP2 possédant uniqguement une extension modifiée vers MP3 peuvent ne pas étre lus.
= Qu’est-ce que I'étiquette ID3 ?
Il s’agit d’un élément attaché a un fichier MP3 contenant les informations relatives au fichier
telles que le titre, l'artiste, I'album, 'année, le genre et un champ commentaire.
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PAUSE

1. Tapez sur [@] en cours de lecture.
= La lecture de la musique est interrompue.
2. Tapez encore sur [@].
= La lecture reprend a I'endroit ou vous I'avez suspendue.

RECHERCHE SUR UNE PISTE

1. Appuyez durant un court moment sur [< >] en cours de lecture de la piste
sélectionnée.

= Ces touches permettent d’effectuer la recherche vers le début ou la fin de la piste.
2. Relachez la touche dés que vous souhaitez reprendre la lecture.
= La lecture commence dés que vous relachez la touche.

LECTURE DE LA PISTE EN COURS A PARTIR DU DEBUT

1. Tapez sur [<] apres 3 secondes de lecture.
= La piste en cours est lue a partir du début.

POUR ECOUTER LA PISTE PRECEDENTE

Tapez sur [<] en moins de 3 secondes de lecture.
Tapez sur [<] deux fois aprés 3 secondes de lecture.

= La lecture de la piste précédente démarre.

LECTURE DE LA PLAGE SUIVANTE

Tapez sur [>].
= La lecture de la piste suivante démarre.
= Pour un fichier VBR, le fichier musical précédant ne pourra étre lu méme si vous
aomoy tapez sur [<] au cours des 3 premiéres secondes de lecture.

38 _écoute de la musique



POUR CREER UNE LISTE DE LECTURE A L'AIDE DE
MEDIA STUDIO DE SAMSUNG

<Media Studio> (Média Studio) vous permet de créer votre propre collection ou liste de
lecture de fichiers audio.
= Avant de démarrer - Branchez le lecteur sur 'ordinateur.

Media Studio doit étre installé sur I'ordinateur.

Comment créer une liste de lecture

= I =g
5] Playlists |5

o)

e
s
|
2 New Playlists < =
[ m . = @ /. D ewrolder
© Selected liss: 0, Al ists: T Elvewnmortayi) (Greurtesiors | @ Dynermic rode.

1. Cliquez sur <Playlists> (Listes de lecture) dans le haut de <Media
Studio> (Média Studio).
= La fenétre <Playlists> (Listes de lecture) apparait.
2. Cliguez sur la touche <New Playlists> (Nouvelles listes de lecture)
au bas de I'écran.
= La fenétre <Create Playlists> (Créer des listes de lecture) apparait.
3. Tapez le titre de la liste de lecture et cliquez sur [OK].
= Une nouvelle liste de lecture est créée et stockée dans la section <Playlists>
(Listes de lecture) de <Media Studio> (Média Studio).
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POUR CREER UNE LISTE DE LECTURE A L'AIDE DE
MEDIA STUDIO DE SAMSUNG (Suite)

Comment ajouter des fichiers musicaux sur une liste de
lecture que vous avez créée

3.
4.

5.

L

5 (&

e 0 1
@ selecta Fles 4. Al les: 12 [ Add Folder | Add File

. Cliquez sur la touche <My PC> (Mon ordinateur) au haut de <Media Studio>.

= La fenétre <My PC> (Mon ordinateur) apparait.

. Cliquez sur la touche <Playlists> (Listes de lecture) dans le coin droit de la

fenétre.
= La fenétre <Playlists> (Listes de lecture) apparait.

Cliquez deux fois sur I'album souhaité dans la fenétre de droite.

Sélectionnez les fichiers que vous souhaitez transférer dans la
fenétre <My PC> (Mon ordinateur).

Cliquez sur I'icone &» .
= Les fichiers sélectionnés sont ajoutés sur la liste de lecture.
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POUR CREER UNE LISTE DE LECTURE A L'AIDE DE
MEDIA STUDIO DE SAMSUNG (Suite)

Exporter une liste de lecture vers votre lecteur a I'aide

de Média Studio
e 8O @
ile. £ :-/‘ —

5EA® O ) olE- TN, ®
Tooe MADIETITM— 52

D 000 °

Playlists

D05 o Plagiists
e

2 ] R s S0z

DBl 8
]
=
2
|z
7

=

B

| @ C—— 1. [Erenracer

@ Seleced st 1, s 6 Bt (@nevpinn

1. Cliquez sur <Playlists> (Listes de lecture) dans le haut de <Media
Studio> (Média Studio).
= La fenétre <Playlists> (Listes de lecture) apparait.

2. Sélectionnez une liste de lecture dans la section <Playlists> (Listes
de lecture).

3. Cliquez sur l'icone &b,
= La liste de lecture sélectionnée est transférée sur le lecteur dossier par

dossier avec <File Browser> (Dossier Navigateur) — <Playlists> (Listes de
lecture).

rg = Le lecteur peut lire jusqu’a 400 listes de lecture et jusqu’a 400 fichiers
remarQUE  MUSICaux par liste de lecture.
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POUR CREER UNE LISTE DE LECTURE SUR VOTRE

LECTEUR MP3

Si vous avez déja téléchargé des fichiers sur votre lecteur MP3, vous pouvez
créer une liste de lecture “favorite” sans avoir a utiliser Media Studio ou votre

ordinateur.

1. Appuyez sur [ 2] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <File Browser>
(Dossier Navigateur), puis tapez sur [@].

3. Tapez sur [~ ~] pour sélectionner <Music> (Musique),
puis tapez sur [@].
= Le menu de la liste de lecture s’affiche.
. Tapez sur [~ ~] pour sélectionner un fichier a ajouter a la
liste de lecture préférée et tapez sur [B].
= Le menu de la liste de lecture apparait.
5. Tapez sur [~ ] pour sélectionner <Add to Playlist>
(Aj. a liste lect.), puis tapez sur [@].
= <Playlist 1> (Liste de lecture 1) & <Playlist 5> (Liste de lecture 5)
apparait.

6. Tapez sur [~ ] pour sélectionner un numéro de liste de
lecture a laquelle ajouter le fichier sélectionné et tapez
sur [@].

= Le fichier sélectionné sera ajouté a liste de lecture.

| Add to Playlist
{

| Playlist 1
{ Playlist2
Playlist 3
Playlist 4
Playlist 5

= VVous pouvez vérifier la liste de lecture dans <Music> (Musique) — <Playlists> (Listes
de lecture) — <Playlist 1> (Liste de lecture 1) a <Playlist 5> (Liste de lecture 5) du

menu principal.

{Q = Vous pouvez ajouter jusqu’a 200 fichiers musicaux dans chaque liste de lecture

REMARQUE
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REMARQUE

LECTURE D'UNE LISTE DE LECTURE

1. Appuyez sur [ D] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Music> (Musique),
puis tapez sur [@].
= La liste musicale apparait.

3. Tapez sur [~ ~] pour sélectionner <Playlists> (Listes de

lecture), puis tapez sur [@].
= La/Les liste(s) de lecture s’affiche(nt).

4. Tapez sur [~ ~] pour sélectionner la liste de lecture
souhaitée, ensuite tapez sur [@].

= Les fichiers musicaux enregistrés dans la liste de lecture
sélectionnée s’affichent.

= Si une liste de lecture n’est pas trouvée, le message <No File>
(Aucun fichier) s’affiche a I'écran.
5. Tapez sur [~ ] pour sélectionner un fichier musical,
ensuite tapez sur [@].
= La lecture du fichier musical débute.

04:29 PM

- Now Playing
Atrtists
Albums
Songs
“Genres
Recorded Files

| Music Browser

=1

04:29 PM (il

Playlist 1 3
Playlist 2
Playlist 3
Playlist4
_Playlist5

= Reportez-vous aux pages 39 et 41 pour savoir comment transférer la liste de

lecture avec <Media Studio>.
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POUR SUPPRIMER UN FICHIER DE LA LISTE DE LECTURE

1. Appuyez sur [ *2] pendant un court moment pour vous déplacer vers le menu

principal.

2. Tapez sur [< >] pour sélectionner <Music> (Musique),
puis tapez sur [@].
= La liste musicale apparait.

3. Tapez sur [~ ~] pour sélectionner <Playlists> (Listes de
lecture), puis tapez sur [@].
= La/Les liste(s) de lecture s’affiche(nt).

4. Tapez sur [~ ~] pour sélectionner la liste de lecture
souhaitée, ensuite tapez sur [@].
= Les fichiers musicaux enregistrés dans la liste de lecture

sélectionnée s’affichent.

| Delete from Playlist

{ Delete All from Playlist |

— O co

5. Tapez sur [~ ] pour sélectionner un fichier & supprimer de la liste de

lecture, ensuite tapez sur [@].
= Le menu de la liste de lecture s’affiche.

6. Tapez sur [~ ~] pour sélectionner <Delete from Playlist> (Suppr. de liste

lect.), puis tapez sur [@].
= Le fichier sélectionné est supprimé de la liste de lecture.

',g = |l estimpossible de supprimer le fichier sélectionné alors qu'il est en cours de

rewamoue | lECHUTE.

POUR SUPPRIMER TOUS LES FICHIERS DE LA LISTE DE

LECTURE

Suivez les étapes 1 a 4 ci-dessus.

5. Tapez sur [@].
= Le menu de la liste de lecture apparait.

6. Tapez sur [~ ] pour sélectionner <Delete All from
Playlist> (Suppr. tt de liste lect.), puis tapez sur [@].
= Tous les fichiers sont supprimés de la liste de lecture.
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POUR UTILISER LE MENU MUSIQUE

Le menu Musique vous permet d’organiser tous les aspects de I'écoute en
cours de lecture — depuis la lecture en boucle de pistes et d’albums a la
sélection du fond d’écran.

Pour régler les effets sonores

Pour profiter d’'un son plus clair.
== j 04:29 PV (]

1. Tapez sur [@] tout en écoutant la musique.
= Le menu <Music> (Musique) apparait.

B Sound Effect 5

C
DNSe W
2. Tapez sur [~ ] pour sélectionner <Sound Play Mode |
Effect> (Effets Sonores), puis tapez sur [@]. Music Play Screen !
= Le menu <Sound Effect> (Effets Sonores) apparait. Play Speed .‘
] Skip Interval
:

Connectto Headset "

3. Tapez sur [~ ] pour sélectionner I'effet sonore
souhaité, ensuite tapez sur [@].

AEp Lifeis cool

Options des effets sonores

= Street Mode (Mode rue) : Pour écouter de la musique plus nette en extérieur
en filtrant certains bruits de la rue. Sélectionnez <Off> (Désactivé) ou <On>
(Activé).

= Clarity (Netteté) : Pour écouter une musique plus nette a qualité améliorée.
Sélectionnez <0 a 2>.

{Q = Tapez sur [@] pour quitter le menu.

REMARQUE
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POUR

UTILISER LE MENU MUSIQUE (Suite)

Régler la fonction Digital Natural Sound engine (DNSe)

Permet de choisir le type de son convenant le mieux a chaque genre de

Musique.
1. Tapez sur [@] tout en écoutant la musique. SE——
= Le menu <Music> (Musique) apparait. | ST EiEE %
2. Tapez sur [~ ] pour sélectionner <DNSe> Play Mode 1
(DNSe), puis tapez sur [@]. Music Play Screen |
= Le menu <DNSe> apparait. Play Speed ;
H Skip Interval -
3. Tapez sur [~ ] pour sélectionner I'effet DNSe ¢ Connectto Headset ”

REMARQUE

souhaité, ensuite tapez sur [@].

= Sélectionnez parmi <Normal> (Normal), <Studio>
(Studio), <Rock> (Rock), <Classical> (Classique),
<Jazz> (Jazz), <Ballad> (Ballade), <Club> (Club), <Rhythm & Blues> (R&B),
<Dance> (Danse), <Concert Hall> (Salle Concert) et <User> (Utilisateur).

= Sélectionner <EQ> (EG) vous permet de régler <3D & BASS> (3D & BASS)
et <User> (Utilisateur).

Life is cool
=t e

/] = Qu’est-ce que I'engin DNSe ?

Digital Natural Sound Engine (Engin de son naturel numérique) (DNSe)
est un effet sonore développé par Samsung pour les lecteurs MP3.

Cette option offre différents réglages sonores visant a améliorer le type de
musique que vous écoutez.
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POUR UTILISER LE MENU MUSIQUE (Suite)

Régler la fonction Digital Natural Sound engine (DNS

e) (Suite)

<EQ>

Vous pouvez ajuster des fréquences particulieres selon vos preferences

1 Dans le menu DNSe, tapez sur [~ ~] pour
sélectionner <User> (Utilisateur), ensuite tapez sur [ >].
2. Tapez sur [~ ] pour sélectionner <EQ>, puis
tapez sur [@].
= L'écran de réglage de <EQ> apparait.
3. Tapez sur [< >] pour sélectionner la fréquence
a ajuster puis tapez sur [~ ] pour ajuster le
niveau de la fréguence.

= |'égaliseur <EQ> vous permet d’ajuster la fréquence
de -10 a +10.

4, Tapez sur [@].
= Le réglage est terminé.
<3D & BASS>
Vous pouvez régler I'effet sonore 3D et I'amplification des basses
1. Dans le menu DNSe, tapez sur [~ ~] pour
sélectionner <User> (Utilisateur), ensuite tapez sur [ >].

E

-
0

(e
2. Tapez sur [~ ] pour sélectionner <3D & BASS>, cw

puis tapez sur [@].
= |'écran de réglage de <3D&Bass> apparait.
3. Tapez sur [< >] pour sélectionner <3D> et
<BASS>, ensulite tapez sur [~ v].
= Vous pouvez sélectionner un niveau de 0 & 4 pour
I'effet sonore <3D> et un niveau de 0 & 4 pour
<BASS>.
4, Tapez sur [@].

= Le réglage est terminé.

3D &BASS

Life is cool

Life is cool

frequences
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POUR UTILISER LE MENU MUSIQUE (Suite)

Pour régler le mode de lecture

Sélectionnez un mode de lecture tel que Répéter.

1. Tapez sur [@] tout en écoutant la musique.

= Le menu <Music> (Musique) apparait. Sound Effect

DNSe

Music Play Screen
Play Speed

Skip Interval
Connect to Headset

2. Tapez sur [~ ] pour sélectionner <Play Mode>
(Mode lecture), puis tapez sur [@].

= Le menu <Play Mode> (Mode lecture) apparait.

b et ()

3. Tapez sur [~ ] pour sélectionner le mode
souhaité, ensuite tapez sur [@].
= Sélectionnez parmi : <Normal>, <Repeat> (Répéter),
<Repeat One> (Répéter une fois) et <Shuffle>
(Aléatoire).

ABY Lifeis cool

Options du mode de lecture

|
!
2
‘

7

= Normal : Lecture ponctuelle et dans I'ordre de toutes les pistes.

= Repeat (Répéter) : Pour la lecture en boucle de tous les fichiers inclus dans le
dossier en cours.

= Repeat One (Répéter 1X) : Répétition ponctuelle d'un fichier.
= Shuffle (Aléatoire) : Lecture aléatoire des fichiers.
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POUR UTILISER LE MENU MUSIQUE (Suite)

Pour sélectionner I’écran de lecture musicale

Faites le choix d’un fond d’écran parmi ceux disponibles ou choisissez votre
propre image a afficher lorsque vous écoutez de la musique.

1. Tapez sur [@] tout en écoutant la musique. T e
= Le menu <Music> (Musique) apparait. 1 s;‘;‘: Effect E

2. Tapez sur [~ ~] pour sélectionner <Music Play Play Mode }
Screen> (Ecran de lecture musicale), puis tapez sur [@]. ;

. Play Speed ’

= Le menu <Music Play Screen> (Ecran de lecture Skip Interval :

;

musicale) apparait. 9 Connectto Headset 7

3. Tapez sur [< >] pour sélectionner un écran de 5

lecture musicale, ensuite tapez sur [@].

= Sélectionnez parmi <Type 1>, <Type 2>,
<Type 3>,<Type 4>, <Album Art> (Info. Album) et <Album Info.> (Image CD).

Options de I'écran de lecture musicale

Life is cool
= e i

- N

Type 1 ~ Type 4 (Type 1 a Type 4) : Pour sélectionner un écran de lecture musicale.

Album Art (Art de I'album) : I'image de la jaquette de I'album s'affiche si elle est
comprise dans I'information de I'étiquette ID3 du fichier musical. Les images de
jaquette de taille moindre que 200 pixels (a I'horizontale) x 200 pixels (a la verticale)
sont soutenues.

Album Info. (Renseignements de I'album) : Les renseignements comprenant le nom
de l'artiste, I'album et son genre s’affichent si I'information de I'étiquette ID3 est stockée
sur le fichier musical.

€] = Sivous définissez <Sammy> sous <Menu Design> (Aspect du menu),
rewaroue <Album Art> (Image CD) ne s’affichera pas.

= Qu'est-ce que I'étiquette ID3 ?
Il s’agit d’'un élément attaché a un fichier MP3 contenant les informations
relatives au fichier telles que le titre, I'artiste, I'album, I'année, le genre et

un champ commentaire. ) .
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POUR UTILISER LE MENU MUSIQUE (Suite)

Pour régler la vitesse de lecture

Vous pouvez accélérer ou ralentir la vitesse de lecture de votre musique

préférée.
1. Tapez sur [@] tout en écoutant la musique. e
= Le menu <Music> (Musique) apparait. 1 Sound Effect 3
. DNS
2. Tapez sur [~ ] pour sélectionner <Play Speed> Playl:/Iode 3
(Vitesse de lecture), puis tapez sur [@]. . Music Play Screen
= Le menu <Play Speed> (Vitesse de lecture) apparait.

3. Tapez sur [~ ] pour sélectionner une vitesse de
lecture musicale, ensuite tapez sur [@].
= Choisissez entre <X 0.7>, <X0.8>, <X 0.9>,
<X 1.0(Normal)>, <X 1.1>, <X 1.2> et <X 1.3>.
= Plus le nombre est élevé, plus la vitesse de lecture
sera rapide.

Skip Interval
9 Connect to Headset

|
|
Play Speed i
|
7

Life is cool

r’ = La vitesse de lecture réglée peut varier de la vitesse réelle en fonction du

revaroue  fichier.

Pour régler le saut d’intervalle

Vous pouvez vous déplacer a marche avant rapide dans un fichier a

différents

intervalles. Vous pouvez sauter une piste entiere ou plusieurs secondes a la fois.

1. Tapez sur [@] tout en écoutant la musique. o mm——
= Le menu <Music> (Musique) apparait. 1 Sound Effect 2
2 . . DNSe
2. Tapez sur [~ ] pour sélectionner <Skip Interval> —— )
(Saut Intervallt_e),_pws tapez sur [@]. ) Music Play Screen ;
= Le menu <Skip interval> (Saut Intervalle) apparait. Play Speed I
3. Tapez sur [~ ] pour sélectionner un saut

d'intervalle, ensuite tapez sur [@].
= Choisissez entre <1 Song>, <5sec>, <10sec>,
<30sec> et <1min>.

rg = Si le fichier a été enregistré a débit binaire variable, la

% Connectto Headset ;

Life is cool

REMARQUE longueur réelle du saut peut varier de celle que vous avez sélectionné.
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POUR UTILISER LE MENU MUSIQUE (Suite)

= Avant de démarrer - Utilisez uniquement un casque Bluetooth approuvé.
Vérifiez si votre casque stéréo Bluetooth est enregistré. <Connect to Headset>
(Connexion au casque d’écoute) apparait si le casque est enregistré. Pour plus
de renseignements, reportez-vous a la rubrique <Pour utiliser un casque stéréo

Bluetooth>. Reportez-vous a la page 87.

Relier des écouteurs stéréo Bluetooth

Vous pouvez établir directement la connexion avec
un casque stéréo Bluetooth enregistré en cours
d’écoute musicale.
1. Tapez sur [@] tout en écoutant la musique.
= Le menu <Music> (Musique) apparait.
2. Tapez sur [~ ] pour sélectionner <Connect to
Headset> (Relier les écouteurs), puis tapez sur [@].

= Si <Bluetooth Mode> (Mode Bluetooth) est réglé sur
<Off> (Arrét), il passe & <On> (Marche).

> oszsemam

\ Sound Effect 5
C DNSe

Play Mode )

Music Play Screen i

Play Speed ,'

Skip Interval '

_{ Connect to Headset &

Life is cool
= He) i

= Une fois la connexion établie, I'icone [ig] s’affiche a I'écran.
= Vous pouvez écouter la musique avec le casque Bluetooth.

Déconnecter les écouteurs stéréo Bluetooth

1. Tapez sur [@] tout en écoutant la musique.
= Le menu <Music> (Musique) apparait.

2. Tapez sur [~ ] pour sélectionner <Disconnect
Headset> (Débrancher écouteurs), puis tapez sur [@].
= La connexion avec le casque Bluetooth est coupée.

rg = En mode Musique, il est impossible de sélectionner
<Play Speed> (Vitesse de lecture), <DNSe>

et <Sound Effect> (Effets Sonores) pendant la

connexion du lecteur au casque stéréo Bluetooth.

REMARQUE

> owsv@m

% Sound Effect 5
C DNSe

Play Mode ]

Music Play Screen &

Play Speed ,'

Skip Interval '

| Disconnect Headset

Life is cool
= v el
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= Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifiez le
bloc-piles. Transférez un fichier vidéo au lecteur. Reportez-vous a la page 34~36

[Q = Tapez sur [*D] pour vous déplacer vers I'écran précédent.

remarque  Appuyez sur [ D] pendant un court moment pour vous déplacer vers le menu principal.

1. Appuyez sur [ *2] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Videos> (vidéos), puis
tapez sur [@].
= La liste des vidéos apparait.

3. Tapez sur [~ ~] pour sélectionner un fichier vidéo,
ensuite tapez sur [@].
= Le fichier vidéo sélectionné commence a défiler a I'horizontale.

POUR INTERROMPRE LE VISIONNEMENT EN COURS

1. Tapez sur [@] pour interrompre le visionnement en cours.
= Le lecteur fait une pause.

2. Tapez encore sur [@].
= Le lecteur reprend le visionnement a partir du dernier point de pause.

[.g = Avant le transfert du fichier image vers le lecteur a I'aide de la fonction <Media
revaroue  Studio>, celui-ci est tout d’abord converti automatiquement au format SVI.
La taille du fichier est également réglée automatiquement.
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POUR VOUS DEPLACER SUR UNE IMAGE SPECIFIQUE

1. En visionnement horizontal, appuyez pendant un >0
moment sur [< >]. wdeoTrackl

= Ceci vous permet de vous déplacer vers 'avant ou vers
I'arriére dans le fichier vidéo.

2. Relachez la touche lorsque vous aurez atteint la
position souhaitée.

= La lecture de la vidéo démarre a partir de cette position.

POUR VISIONNER LE FICHIER VIDEO PRECEDENT

1. Tapez sur [<] dans les 3 secondes suivant le début
de la lecture de la vidéo.
Tapez deux fois sur [¢], 3 secondes suivant le
début de la lecture de la vidéo.

= Vous revenez sur la vidéo précédente.

LIRE LE FICHIER VIDEO SUIVANT

1. Tapez sur [@] \;it?e:TrackZ

= \Jous passez sur la vidéo suivante. o
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POUR UTILISER LE MENU VIDEO
Réglage d'un signet
Lorsque vous aurez défini un signet, vous pourrez facilement cette position.

1. Tapez sur [@] & la sceéne souhaitée en cours
de visionnement.

= e menu <Video> (Vidéo) s'affiche.

Go to Bookmark

2. Tapez sur [~ ] pour sélectionner <Add QAR SR
Bookmark> (Ajouter un signet), puis tapez || g:lgs'“”ess
o
sur [©] N o, P ConnecttoHeadset
= La position lecture / arrét actuelle sera ajoutée

au signet.
= Le symbole [ m] s'affiche sur la barre d'état.
rg = Si vous avez déja mis un signet, la fenétre « Ecraser » apparait. Si vous

REVRROUE se_lectlonnez <Yes> (Oui), le signet déja mis est supprimé et un nouveau signet
mis en place.

= Vous pouvez ajouter un signet a chaque ficher vidéo pour un total de 50
signets.

Pour vous déplacer sur (lecture) / supprlmer le S|gnet

1. Tapez sur [@] pour interrompre le J r
visionnement en cours. Add Bookmark

= Le menu <Video> (Vidéo) s'affiche. H o

- . . Delete Bookmark
2. Tapez sur [~ ] pour sélectionner <Go to Btightness

Bookmark> (Aller au signet) ou <Delete | bnse

Bookmark> (Supprimer le signet), puis P Connect to|Headset

tapez sur [@]. - —

= Sivous sélectionnez <Go to Bookmark> (Aller au signet), le lecteur passe
au signet sélectionné dans le fichier et lance la lecture.

= <Delete Bookmark> (Supprimer signet) enléve le signet sélectionné du fichier
vidéo.

77 .

r’J = Tapez sur [@] pour quitter le menu.
REMARQUE . o
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POUR UTILISER LE MENU VIDEO (Suite)

'Q = Tapez sur [@] pour quitter le menu.

REMARQUE D1 régler la luminosité

Vous pouvez régler la luminosité de I'écran.
1. Tapez sur [@] pour interrompre le
visionnement en cours.
= Le menu <Video> (Vidéo) apparait. f
2. Tapez sur [~ ] pour sélectionner 5&_3&1'19 B"Okm’“‘% =
<Brightness> (Luminosité), puis tapez sur [@]. | [‘)N'SEA -
= Le menu <Brightness> (Luminosité) apparait. | . o
3. Tapez sur [~ ] pour sélectionner la —_—
luminosité souhaitée, ensuite tapez sur [@].
= Choisissez entre <0~10>.

Pour régler I’engin Digital Natural Sound engine
(DNSe) £ZEngm e son numérique naturel)

Pour sélectionner le son parfait pour tout genre de vidéo.

1. Tapez sur [@] pour interrompre le gar oz
visionnement en cours. Add Bookmark
= Le menu <Video> (Vidéo) apparait.

2. Tapez sur [~ v] pour sélectionner <DNSe>, [+ -
rightness

puis tapez sur [@]. ‘DNse gD o
= Le menu <DNSe> apparait. Connectto Headset ]
3. Tapez sur [~ ] pour sélectionner I'effet .
DNSe souhaité, ensuite tapez sur [@].
= Choisissez entre <Normal>, <Drama>(Drame) et <Action>.
* Qu'est-ce que I'engin DNSe ? -
Digital Natural Sound Engine (Engin de son naturel numérique) (DNSe) est un
effet sonore développé par Samsung pour les lecteurs MP3. L'engin vous offre
différentes qualités de son pour améliorer le genre de musique que vous écoutez.
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POUR UTILISER LE MENU VIDEO (Suite)

= Avant de démarrer - Utilisez uniquement un casque Bluetooth approuvé.
Vérifiez si votre casque stéréo Bluetooth est enregistré. <Connect to
Headset> (Connexion au casque d’écoute) apparait si le casque est
enregistré. Pour plus de renseignements, reportez-vous a la rubrique
<Pour utiliser un casque stéréo Bluetooth>. Reportez-vous a la page 81.

Pour établir la connexion avec un casque stéréo Bluetooth

Vous pouvez établir directement la connexion avec un casque stéréo
Bluetooth enregistré en cours de visionnement d’une vidéo.
1. Tapez sur [@] pour interrompre le visionnement en cours.
= Le menu <Video> (Vidéo) apparait. = v
2. Tapez sur [~ ] pour sélectionner i ’;"d B;°k':a"‘k
<Connect to Stereo Headset> (Relier les i
écouteurs stéréo), puis tapez sur [@]. B 5iighiness
= Si <Bluetooth Mode> (Mode Bluetooth) est réglé DNSe
sur <Off> (Désactivé), il passe directement en
mode <On> (Activé).
= Lorsque la connexion est bien établie, I'icbne
[@&»] apparait a I'écran.
= Les écouteurs stéréo vous permettent de profiter de la bande sonore d'un
fichier vidéo.
Pour couper la connexion du casque stéréo BIuetooth

Delete Bookmark

1. Tapez sur [@] pour interrompre le = r
visionnement en cours. Add Bookimark

. - 4z N Go to Bookmark
= Le menu <Video> (Vidéo) apparait. .
2. Tapez sur [~ ] pour sélectionner | Brightness
<Disconnect Headset> (Débrancher DNSe

écouteurs), puis tapez sur [@]. A Disconrectreadset ———  f-
= La connexion avec le casque Bluetooth est coupée. S—= 2 .
= En mode Vidéo, il est impossible de sélectionner <DNSe> pendant la
revamoue CONNEXion du lecteur au casque stéréo Bluetooth.
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= Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifiez la
batterie.

= Tapez sur [*D] pour vous déplacer vers I'écran précédent.
revaroue  Appuyez sur [ *D] pendant un court moment pour vous déplacer vers le menu
principal.

1. Appuyez sur [ *2] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Pictures> (Images),
puis tapez sur [@].
= La fenétre de prévisualisation apparait.

3. Tapez sur [~ ~ ¢ > ] pour sélectionner une image, puis
tapez sur [@].
= La photo sélectionnée s’affiche.
= Tapez sur [ *D] pour vous déplacer vers I'écran précédent.

Pour vous déplacer sur la photo précédente/suivante

1. En visionnement horizontal, tapez sur [< >].
= La photo précédente/suivante s'affiche.

r,g = Un fichier JPG contenant les données incorrectes d'une vignette s'affiche dans [&].
remarque = Certaines photos peuvent étre lentes a s'afficher.

= Lorsque vous transférez une photo sur le lecteur a l'aide de <Media Studio>, elle
est automatiquement convertie au format JPG avant son transfert. La taille du
fichier est aussi ajustée.

= Le <File Browser> (Dossier Navigateur) est aussi utile pour rechercher une photo.
Reportez-vous a la page 21.
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POUR UTILISER LE MENU PHOTO

f.ﬁ = Tapez sur [@] pour quitter le menu.
REMARQUE , . .
Pour écouter la musique en regardant VOS Images

Vous permet d’'écouter la derniére chanson lue tout en regardant une image.

1. Tapez sur [@] en regardant une image.

= Le menu <Pictures> (Photos) apparait. 7
Start Slideshow

2. Tapez sur [~ ] pour sélectionner 4 Sideshow speed
i i i oom
<Music> (Musique), puis tapez sur [@]. e
= Le menu <Music> (Musique) apparait. Select as My Skin
s bd iR

3. Tapez sur [~ ] pour sélectionner <Off>
(Désactivé) ou <On> (Activé), puis tapez
sur [@].
= <Off> (Désactivé) : Aucune musique d’atmosphere en regardant une image.
= <On> (Activé) : Vous permet d'écouter la derniére piece musicale lue tout en

regardant une image.

Pour visualiser un diaporama

Comment procéder 1 =
{ start Slideshow ]

1. Tapez sur [@] en regardant une image.
= icone s'affichera a I'écran et le lecteur lancera le
diaporama.

Comment procéder 2

1. En mode prévisionnement d’'images, tapez sur [@].
= La fenétre Start Slideshow (Démarrer diaporama)
s'affiche.

2. Tapez sur [@].
= ['icone s'affichera a I'écran et le lecteur lancera le diaporama.
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POUR UTILISER LE MENU PHOTO (Suite)

Arrét du diaporama

g

Comment procéder 1

~+ Music
1. En mode diaporama, tapez sur [@]. ¥
. A . Slideshow Speed
= Le diaporama s’arréte. - o
L, Rotate
Comment procéder 2 Select as My Skin
1. En mode diaporama, tapez sur [@]. b i

= Le menu <Pictures> (Images) apparait.

2. Tapez sur [~ ] pour sélectionner <Stop Slideshow>
(Arrét diaporama), puis tapez sur [@].

= Le diaporama s’arréte.

Pour régler la vitesse du diaporama

1. Tapez sur [@] en regardant une image.

= Le menu <Pictures> (Images) apparait. | Music
Stop Slideshow

L]

2. Tapez sur [~ ] pour sélectionner e
<Slideshow Speed> (Vitesse diaporama), Zoom

. Rotate
puis tapez sur [@] Select as My Skin

= Le menu <Slideshow Speed> (Vitesse LR i

%

diaporama) apparait.

3. Tapez sur [~ ~] pour sélectionner une vitesse, ensuite tapez sur [@].
= Sélectionnez parmi : <Fast> (Rapide), <Normal> et <Slow> (Lente).
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POUR UTILISER LE MENU PHOTO (Suite)

Pour agrandir une photo

Vous pouvez zoumer une photo.

1. Tapez sur [@] en regardant une image.
= Le menu <Pictures> (Images) apparait. | Music
2 . Start Slideshow
2. Tapez sur [A_ ~] pour sélectionner  Siideshow Speed
<Zoom>, puis tapez sur [@]. o ]
= Le menu <Zoom> apparait. Rotate )
, . Select as My Skin
3. Tapez sur [~ ] pour sélectionner un y :
facteur d'échelle, ensuite tapez sur [@].
= Choisissez entre <100%>, <200%> et <400%>.
4. Tapez sur [~ ¢ »] pour se déplacer vers la zone de I'image a grossir.

48

o

Pour annuler le zoom

Comment procéder 1

1. Tapez sur [@] a l'intérieur d’'une image
grossie.
= La taille initiale revient.

Comment procéder 2

1. Tapez sur [@] en regardant une image.
= Le menu <Pictures> (Images) apparait. R DRt T

2. Tapez sur [~ ] pour sélectionner
<Zoom>, puis tapez sur [@].
= Le menu <Zoom> apparait.

3. Tapez sur [~ v] pour sélectionner <100%>, puis tapez sur [@].
= La taille initiale revient.

O 200%
g 0400%

fg = Une grande photo peut prendre beaucoup de temps a s’agrandir.

REMARQUE
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POUR UTILISER LE MENU PHOTO (Suite)

Pour faire pivoter I'image

Vous pouvez tourner une image, a votre gré.

1. Tapez sur [@] en regardant une image.

= Le menu <Pictures> (Images) apparait. - Music
P . | Start Slideshow
2. Tapez sur [~ ~] pour sélectionner Slideshow Speed

<Rotate> (Pivoter), puis tapez sur [@]. " Zoom

= Le menu <Rotate> (Pivoter) apparait. Select as My Skin

3. Tapez sur [~ ] pour sélectionner un 30 e
angle souhaité, ensuite tapez sur [@].
= Choisissez entre <Left 90°>, <Right 90°> et <180°>.

Pour sélectionner une photo comme fond d’écran

Vous pouvez utiliser une photo de votre choix comme fond d’écran.

1. Sélectionnez un fichier photo a utiliser
comme fond d'écran, puis tapez sur [@]. . Music

= Le menu Photo s'affiche. Start Slideshow
. ] Slideshow Speed
2. Tapez sur [~ ] pour sélectionner <Select Zoom
Rotate

as My Skin> (Sélectionner comme

habillage), puis tapez sur [@].

= La fenétre de confirmation apparait.
3. Tapez sur [< >] pour sélectionner <Yes> (Oui), puis tapez sur [@].

= La photo sélectionnée est établie comme fond d’écran.
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ecoute de la radio =M
= Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifiez la
batterie.

[Q = Tapez sur [*D] pour vous déplacer vers I'écran précédent.
revarque  Appuyez sur [*D] pendant un court moment pour vous déplacer vers le menu
principal.
1. Appuyez sur [ D] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <FM Radio> (radio FM),
puis tapez sur [@].
= La réception de la radio FM est activée.

POUR UTILISER LA FONCTION MUTE (MUET)

Tapez sur [@] tout en écoutant la radio FM.
= Le son est désactivé.

Tapez sur [@] une fois pour reprendre I'écoute.

r{l = Branchez toujours vos écouteurs au lecteur lorsque vous recherchez ou
programmez les fréquences. Les écouteurs sont utilisés comme antennes de
réception des ondes FM

= |l se peut que le lecteur ne trouve pas de fréquences FM disponibles dans les
régions ou la réception est mauvaise.

= La fonction Bluetooth est désactivée pendant que vous écoutez la radio FM.

REMARQUE
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RECHERCHE DE STATIONS FM

1. En mode Manuel, appuyez sur [< >] pendant un moment,
ensuite relacher.
= <Auto Searching...> (Recherche auto...) s'affiche a I'écran.

La recherche s’arréte sur la fréquence la plus prés du point ou la
touche est relachée.

~ MANUAL

91.9wH:

|~ Auto Seaching...
iES]

ou,

1. Tapez sur [< >] pour avancer parmi les fréquences une
par une en mode Manuel.

= Change de fréquence a chaque nouvelle pression du touche.

04:29 PM

- MANUAL

91.9mH;
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POUR UTILISER LE MENU RADIO FM

Pour basculer vers le Mode présélection

Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos

présélections FM une a la fois.

1. Tapez sur [@] en mode Manuel.
= Le menu <FM Radio> (Radio FM) apparait.

2. Tapez sur [~ ] pour sélectionner <Go to Preset
Mode> (Aller au mode pré-programmation), puis
tapez sur [@].
= <PRESET> s’affiche.

"/' = Si aucune fréquence n’est présélectionnée, le

message <Preset list does not exist> (Liste présél.
n’existe pas.) s'affiche et le lecteur ne bascule pas en
<Preset Mode> (Mode Présélection).

REMARQUE

04:29 PV (@]

-

- ~
W PRESET ?
S =

91.9wH:

= Si vous sélectionnez <Default Set> (Réglage par défaut) dans <Settings>
(Parameétres) — <System> (Systéme), les fréquences présélectionnées

sont supprimées.

Pour basculer vers le mode manuel

Sélectionnez ce mode si vous souhaitez effectuer une recherche

manuelle d'une fréquence a la fois sur la bande FM.

1. Tapez sur [@] en Mode Présélection.
= Le menu <FM Radio> (Radio FM) apparait.

2. Tapez sur [~ ~] pour sélectionner <Go to Manual
Mode> (Aller au mode manuel), puis tapez sur [@].

= <MANUAL> s'affiche.
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POUR UTILISER LE MENU RADIO FM (Suite)

Programmation de stations sur la mémoire

Vous pouvez stocker jusqu’a 30 stations sur la mémoire du lecteur
MP3 et y retourner simplement en appuyant sur un numeéro. Laissez
le lecteur MP3 choisir uniquement les stations que vous voulez

en mode manuel ou trouvez et stockez toutes les stations locales

automatiquement.

Manuel — choisissez uniquement les stations que vous voulez
stocker

1. Tapez sur [< >] en Mode Manuel pour —

4 : A " Goto Preset Mode
sélectionner une fréquence.
= Le menu <FM Radio> (Radio FM) apparait. Auto Preset

Start Recording
2. Tapez sur [@]. FM Sensitivity
FM Region

3. Tapez sur [~ ] pour sélectionner <Add to
Preset> (Ajouter aux présél.), puis tapez sur [@].
= La fréquence sélectionnée s’ajoute sur la Liste S
Présélection accompagnée d'un symbole [ . ] sur la
barre de la fréquence sélectionnée.

4. Pour définir d’autres fréquences présélectionnées, suivez les étapes 1 a
3 ci-dessus.

',/l = Si la fréquence est déja présélectionnée, le message <This preset already
remaroue  EXists> (Cette présélection existe déja) s'affiche et la présélection est
désactivée.
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POUR UTILISER LE MENU RADIO FM(Suite)

Programmation de stations sur la mémoire (Suite)

Automatique — pour enregistrer automatiquement toutes les
stations regues par le lecteur

1. Tapez sur [@] en mode Radio FM. o
= Le menu <FM Radio> (Radio FM) apparait. | GotsREEzi:

Add to Preset
2. Tapez sur [~ ~] pour sélectionner <Auto
s 2 . . Start Recording
Preset> (Présélection auto), puis tapez sur [@]. FM Sensitvity
= La fenétre de confirmation apparait. FM Region

3. Tapez sur [< >] pour sélectionner <Yes> (Oui), ]
puis tapez sur [@]. et
= \ous pouvez programmer automatiquement jusqu’a 30
sélections.

Annulation de la programmation automatique

Si vous souhaitez annuler la programmation automatique, tapez sur
[@] durant le processus.

= La programmation automatique est annulée et seules les fréquences
programmeées a ce point sont enregistrées.

@/] = Sivous souhaitez écouter votre lecteur MP3 dans une autre ville, il sera
revamoue Probablement nécessaire de reprogrammer vos stations.
Répétez simplement le processus pour supprimer les stations
programmeées et en programmer de nouvelles.
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POUR UTILISER LE MENU RADIO FM (Suite)

Ecoute des stations programmées

Lorsque en Mode Présélection, tapez sur [< >] pour
défiler la liste des postes présélectionnés.

= Vous pouvez alors écouter la fréquence radio attribuée a
ce numéro.

Suppression d'une station programmée

Suivez les étapes suivantes pour supprimer les fréquences tout en

écoutant la radio FM.

1. Lorsque en Mode Présélection, tapez sur [ >]
pour rechercher une fréquence présélectionnée a
supprimer, ensuite tapez sur [8].

= Le menu <FM Radio> (Radio FM) apparait.

2. Tapez sur [~ ] pour sélectionner <Delete from
Preset> (Suppr. du prérégl.), puis tapez sur [@].
= La fréquence sélectionnée est supprimée.

3. Pour supprimer des fréquences présélectionnées,
suivez les étapes 1 et 2 ci-dessus.

=y
* Go to Manual Mode
Auto Preset
Start Recording
FM Sensitivity
FM Region
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POUR UTILISER LE MENU RADIO FM (Suite)

Pour enregistrer une émission de Radio FM

Vous pouvez enregistrer une émission de radio FM
en tout temps pendant I'écoute de la radio.

—

' Go to Manual Mode

1. Tapez sur [ >] pour sélectionner une fréquence pour | Deletefrom Preset

Auto Preset

enregistrement en mode Radio FM et tapez sur [@].
* Le menu <FM Radio> (Radio FM) apparait. FM Sensitivity

2. Tapez sur [~ ~] pour sélectionner <Start
Recording> (Démarrer enreg.), puis tapez sur [@].
= Le nom du fichier s’affiche et le lecteur commence

I'enregistrement.

FM Region

Pour arréter I’enregistrement FM

1. Durant I'enregistrement, tapez sur [@].
= Un message s'affiche vous demandant si vous voulez

écouter la lecture du fichier rfeccemment enregistré. 91.9mH:
2. Tapez sur [< »] pour sélectionner <Yes> (Oui) ou
<No> (Non), puis tapez sur [@].
= <Yes> (Oui) — le fichier enregistré est lu. - 00:01:15
= <No> (Non) — le fichier enregistré n’est pas lu. 07:18:05
= Le fichier enregistré est stocké dans <File Browser> LTSRS

(Dossier Navigateur) —»<Recorded Files> (Fichiers
enregistrés).

04:29 PM (il

[Q = Vous pouvez stocker un maximum de 999 fichiers d’enregistrement de

remarque  Fadio FM.

= VVous pouvez effectuer jusqu’a 23 heures d’enregistrement environ (a 96

kbit/s, 1 Go)

= Le nom du fichier d’enregistrement sera spécifié automatiquement, par
exemple, “FM_000. MP3". “FM” indique un fichier d’enregistrement FM et

“000" désigne le numéro du fichier d’enregistrement.
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POUR UTILISER LE MENU RADIO FM (Suite)

Pour régler la Sensibilité FM

Permet la réception de plus ou moins de fréquences radio FM. Réglez
la fonction <FM Sensitivity> (Sensibilité FM).

1. Tapez sur [@] en mode Radio FM.

1

= Le menu <FM Radio> (Radio FM) apparait. Go to Manual Mode
Delete from Preset

Auto Preset

2. Tapez sur [~ ] pour sélectionner <FM :
Start Recording

Sensitivity> (Sensibilité FM), puis tapez sur [@].

= Le menu <FM Sensitivity> (Sensibilit¢ FM) apparait. FM Region
3. Tapez sur [~ ] pour sélectionner le niveau de ;
recherche, ensuite tapez sur [@]. = ]

= Sélectionnez entre <High> (Haut), <Middle> (Milieu) et
<Low> (Bas).

= Sélectionner <High> (Haute) augmente le nombre de fréquences regues.
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POUR UTILISER LE MENU RADIO FM (Suite)

Réglage de larégion FM
Vous pouvez modifier les réglages de région FM avant d'aller a
I’étranger.
1. Tapez sur [@] en mode Radio FM.

= Le menu <FM Radio> (Radio FM) apparait.

' Go to Manual Mode
Delete from Preset

2. Tapez sur [~ ~] pour sélectionner <FM Region> | AutoPreset.
L. f Start Recording
(Région FM), puis tapez sur [@]. FM Sensitivity
= Le menu <FM Region> (Région FM) apparait. FM Region

3. Tapez sur [~ ] pour sélectionner la fréquence
FM présente dans votre région et tapez sur [@].

= Sélectionnez entre <Korea/US> (Corée/USA),
<Japan> (Japon) ou <Other Countries> (Autres pays).

rg = Si vous modifiez la fonction <FM Region> (Région FM) de votre lecteur, les
fréquences radio préprogrammées sont supprimées.

= La région FM peut étre supprimée ou modifiée en fonction de la région
cible du lecteur.
= Bande de fréquences par région
- Korea/US (Corée/Etats-Unis) : recherchez des fréquences FM comprises
entre 87,5 MHz et 108,0 MHz pour les lecteurs de 100 kHz.
- Japan (Japon) : recherchez des fréquences FM comprises entre 76,0 MHz
et 108 MHz pour les lecteurs de 100 kHz.
- Other Countries (Autres pays) : recherchez des fréquences FM comprises
entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.

REMARQUE
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<Media Studio> vous permet le transfert des données de blogue et des fichiers

enregistrés au format RSS sur le lecteur pour votre plaisir.

= Qu'est-ce que RSS ?

revarque  RSS représente Rich Site Summary (Résumé d'un site riche) ou Really Simple Syndication
(Syndication réellement simple). Il s'agit d'un systeme de transmission de données au format
XML utilisé pour transmettre de I'information sur les sites Web fréquemment mis a jour (les
sites de nouvelles ou les blogues) de facon plus conviviale et facile.
= Qu’'est-ce que la diffusion de données ?

Vous pouvez recevoir automatiquement des informations mises-a- jour sans avoir a
accéder a des sites de nouvelles, de blogue ou UCC fréquemment visités a chaque fois.

= Avant de débuter - Media Studio doit étre installé sur votre ordinateur.

Reportez-vous a la page 33.

POUR ENREGISTRER UNE CHAINE

Vous pouvez créer une nouvelle chaine en vous enregistrant sur un site Web ou des

pages Web pouvant accueillir le format RSS.

1. Cliquez sur <Subscribe> (S’abonner) en s sowmm
dessous de <Datacasts> (Diffusion de * Enter th s of 5 o o . (10> to st
données) dans <Media Studio> (Média I
Studio). ——

2. Saisissez une adresse dans <URL> et 2
cliquez sur <»Next> (» Suivant).
= Lorsque vous copiez une adresse Web et cliquez

sur <Subscribe> (S'abonner), I'adresse copiée
s'affiche automatiquement dans <URL>.
= La fenétre de confirmation apparait si 'adresse Web peut accueillir le format RSS.

3. Cliquez sur <OK>.
= La chaine souhaitée est enregistrée.
= L'icone || apparait dans Diffusion de données pour I'enregistrement de la chaine.

= Reportez-vous a <Datacasts> (Diff. de donn.) de <Media Studio> pour obtenir des

remarque  iNstructions détaillées.
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POUR CREER UNE NOUVEAU GROUPE DE CHAINES

Vous pouvez créer un nouveau groupe de gestion des chaines par catégorie.

1. Cliquez sur <New Group> (Nouveau groupe) B o creaton 5
en dessous de <Datacasts> (Diffusion de [FS—
données) dans <Media Studio> (Média Studio). S

2. Tapez le nom de groupe et sa description, puis s
cliquez sur <OK>. =

POUR TRANSFERER UNE Sl

DIFFUSION DE DONNEES DE <MEDIA STUDIO>

= Avant de débuter — Raccordez le lecteur a votre ordinateur.
Media Studio doit étre installé sur votre ordinateur. Reportez-vous a la page 33.

1. <Media Studio> est lancé automatiquement
des que le lecteur est raccordé a votre
ordinateur.
= Si le programme n’est pas lancé automatiquement,

double-cliquez sur l'icone (<) de <Media Studio> sur
votre bureau.

2. Cliquez sur <Datacasts> (Diffusion de
données) dans le haut de <Media Studio>
(Média Studio).
= La liste de chaines du groupe Diffusion de données

apparait.

. Cliquez sur le groupe de chaines souhaité.

. Cliquez sur la chaines souhaitée.

. Sélectionnez l'article de forum que vous souhaitez transférer.

. Cliquez sur I'icbne & .
= Larticle de forum de la chaine sélectionnée est transféré sur le lecteur dans <File Browser> (Dossier

Navigateur) — <Datacasts> (Diffusions).

o g~ w

r,g = Cliquez sur [t dans le haut de <Media Studio> pour vous déplacer sur I'écran précédent.
remarque™ Dans <Datacasts> (Diffusion de données) de <Media Studio> (Média Studio), si I'article posséde
une piéce jointe, vous pouvez télécharger la piece jointe sur le lecteur. Cependant, en raison des

politiques du site Web concerné, il peut s’avérer impossible de télécharger la piece jointe.
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VISUALISATION DES DIFFUSIONS DE DONNEES

Vi

ous pouvez visualisez les articles de forum des chaines ajoutées a <Datacasts>

(Diffusion de données).
= Avant de démarrer - Transférez sur le lecteur I'article de forum venant d’une

chaine avec <Media Studio> (Media Studio). Reportez-vous a la page 72

f-ﬂ = Tapez sur [*D] pour vous déplacer vers I'écran précédent.
revarque  Appuyez sur [*D] pendant un court moment pour vous déplacer vers le menu

N

4. Tapez sur [~ ] pour sélectionner un forum, ensuite

principal.

Appuyez sur [ *2] pendant un court moment pour vous
déplacer vers le menu principal.

Tapez sur [< >] pour sélectionner <Datacasts>
(Dif. donn), puis tapez sur [@].
= La liste des diffusions de données apparait.

Tapez sur [~ ] pour sélectionner un forum, ensuite

tapez sur [@].

= Le titre est le méme que celui de la chaine ajoutée a
<Datacasts> (Diffusion de données) de <Media Studio> (Média
Studio.

tapez sur [@].
= La liste des fichiers apparait.

M Datacast 3

Licéne & : Texte principal de I'article transféré M Datacast 4

L'icone ¢g] : Fichier photo
Licone fJ : Fichier musical
L'icone @ : Fichier vidéo e 2

5. Tapez sur [~ ] pour sélectionner un article de forum, ensuite tapez sur [@].

= La lecture de I'article de forum commence.
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Loffre groupée Prime Pack (Pack plus) vous permet de profiter de
plusieurs fonctions comme la lecture de textes et I'enregistrement vocal.

LECTURE DE TEXTE

Qu'il s’agisse d’un roman, du manuscrit d’'une nouvelle histoire ou de votre article de
recherche, le lecteur MP3 vous laisse le lire... tout en écoutant de la musique !

= Avant de démarrer - Allumez le lecteur et vérifiez I'état de la batterie. Transférez les
fichiers texte sur le lecteur a 'aide de <Media Studio>. Reportez-vous a la page 34~36.

7 . . -
M = Tapez sur [*D] pour vous déplacer vers I'écran précédent.

REMARQUE  Appuyez sur [ *D] pendant un court moment pour vous déplacer vers le menu principal.

1. Appuyez sur [ D] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Prime Pack>
(Pack plus), puis tapez sur [@].
= La liste <Prime Pack> (Pack plus) apparait.

3. Tapez sur [~ ] pour sélectionner <Text> (Texte),
puis tapez sur [@].
= La liste des fichiers texte apparait.

4. Tapez sur [~ ~] pour sélectionner un fichier texte,
ensuite tapez sur [@].
= Le texte s'affiche a I'écran.

Text 5,
Voice REC

Games

Address Book

Pour vous déplacer sur la page précédente/suivante

Tapez sur [@].

= Appuyez sur [ »] pendant un court moment pour vous déplacer vers la page

précédente ou suivante.

Z) = Votre lecteur MP3 peut accueillir le format de fichiers TXT en mode Texte.
revaroue ® VOUS pouvez également utiliser la fonction <File Browser> (Dossier Navigateur)

pour rechercher un fichier texte.
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POUR UTILISER LE MENU TEXTE
[.g = Tapez sur [@] pour quitter le menu.
™ pour écouter la musique en lisant du texte

Vous permet d'écouter la derniére piéce musicale lue tout en lisant du texte.

1. Tapez sur [@] pendant la lecture du texte.

= Le menu <Text> (Texte) apparait.
Go to 1st Page

2. Tapez sur [~ ] pour sélectionner <Music> Add Bookmark
(Musique), puis tapez sur [@]. Go to Bookmark
. . N Delete Bookmark
= Le menu <Music> (Musique) apparait. Text Viewer Color

Font Size

3. Tapez sur [~ ] pour sélectionner un mode, View Type

ensuite tapez sur [@].

= <Off> (Désactivé) : Aucune musique d’atmosphere
pendant la lecture du texte.

= <On> (Activé) : Vous permet d’écouter la derniére piéce musicale lue tout en
lisant du texte.

Pour revenir a la premiére page

Procédure a suivre pour lire un texte a partir de la premiére page.

1. Tapez sur [@] pendant la lecture du texte.
= Le menu <Text> (Texte) apparait.

Go to 1st Page

2. Tapez sur [~ ] pour sélectionner <Go to 1st (A;ddthOkTarkk
a N . 0 to Bookmarl
Page> (Aller a la 1ére page), puis tapez sur [@]. E——,
= La fenétre de confirmation pour revenir a la premiére Text Viewer Color
page s’affiche. Font Size

View Type

3. Tapez sur [€ »] pour sélectionner <Music>
(Musique), puis tapez sur [@].
= Se déplace a la premiére page.
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POUR UTILISER LE MENU TEXTE (Suite)

[.Q = Tapez sur [@] pour quitter le menu.
REMARQUE . .
Pour instaurer un S|gnet

Mettez un signet pour revenir sur ce point dans le texte en tout temps.

1. Tapez sur [@] pendant la lecture du texte.

= Le menu <Text> (Texte) apparait.
Go to 1st Page

2. Tapez sur [~ ] pour sélectionner <Add
Bookmark> (Ajouter signet), puis tapez sur [@]. Go to Bookmark

'é & i Delete Bookmark
= L'écran texte actuel posséde un signet et le symbole clete Bookmar

) e X Text Viewer Color
[@ ] s'affiche dans le coin gauche du haut. Font Size

'(l = Si vous avez déja mis un signet, la fenétre “Ecraser” View Type

apparait. Si vous sélectionnez <Yes> (Oui), le signet
déja mis est supprimé et un nouveau signet mis en
place.

= Un seul signet peut étre mis par fichier texte et vous pouvez mettre un
maximum de 100 signets.

REMARQUE

Accéder a (lire)/Supprimer un signet

1. Tapez sur [@] pendant la lecture du texte.

= Le menu <Text> (Texte) apparait. ~ Music
L ) Go to 1st Page
2. Tapez sur [~ ] pour sélectionner <Go to Add Bookmark
Bookmark> (Accéd. a signet) ou <Delete
> i i i . Delete Bookmark
bookmark (Supprlmer S|gngt), puis tapez sur [@] e\ o
= Vous accédez au signet sélectionné lorsque vous Font Size

cliquez sur <Go to Bookmark> (Accéd. a Signet) et le View Type
supprimez du fichier texte lorsque vous sélectionnez
<Delete Bookmark> (Supprimer signet).
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POUR UTILISER LE MENU TEXTE (Suite)

Réglage de la couleur de la visionneuse de texte

Choisissez votre couleur préférée pour afficher le texte.
1.

Tapez sur [@] pendant la lecture du texte.
= Le menu <Text> (Texte) apparait.

. Tapez sur [~ ] pour sélectionner <Text Viewer

Color> (Coul. visionn. text), puis tapez sur [@].

= La fenétre du menu <Text Viewer Color> (Couleur du
visualiseur de texte) apparait.

. Tapez sur [¢ >] pour sélectionner une couleur de

visionnement de texte, ensuite tapez sur [@].
= Sélectionnez entre <Type 1> jusqu’a <Type 6>.

Pour modifier la taille de police

Go to 1st Page
Add Bookmark
Go to Bookmark

Delete Bookmark

Text Viewer Color

Font Size
View Type

Vous pouvez modifier la taille de la police du texte.

1.

Tapez sur [@] pendant la lecture du texte.
= Le menu <Text> (Texte) apparait.

. Tapez sur [~ ] pour sélectionner <Font Size>

(Coul. visionn. text), puis tapez sur [@].

= La fenétre du menu <Font Size> (Coul. visionn. text)
apparait.

. Tapez sur [¢ >] pour sélectionner la taille de

police souhaitée, ensuite tapez sur [@].

Go to 1st Page
Add Bookmark
Go to Bookmark

Delete Bookmark

Text Viewer Color

View Type

= Sélectionnez parmi : <Small> (Petite), <Medium> (Moyenne) et <Large>

(Grande).
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POUR UTILISER LE MENU TEXTE (Suite)

Pour définir I'apparence du texte

Le texte peut étre vu horizontalement ou a la verticale.
1. Tapez sur [@] pendant la lecture du texte.

= Le menu <Text> (Texte) apparait. Music
z . . Go to 1st Page
2. Tapez sur [~ ] pour sélectionner <View Type> T e e

(Visualiser le modéle), puis tapez sur [@]. Go to Bookmark
= ’écran <View Type> (Visualiser le modele) apparait.

Delete Bookmark
Text Viewer Color

3. Tapez sur [~ ] pour sélectionner le modéle, e
puis tapez sur [@]. L
= Sélectionnez <Normal> (Normal) ou <Horizontal> (A
I'horizontale.

= Sélectionnez <Normal> pour visualiser le texte a la verticale et sélectionnez
<Horizontal> pour pivoter I'écran a I'horizontale.
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POUR UTILISER LE MENU TEXTE (Suite)

Pour définir la langue d’un texte

Vous pouvez sélectionner la langue de visionnement d’un texte.

1. Tapez sur [@] pendant la lecture du texte. o2 =
= Le menu <Text> (Texte) apparait. [ Language —|d

2. Tapez sur [~ ] pour sélectionner <Language>
(Langue), puis tapez sur [@].

La liste <Language> (Langue) apparait.

<English>, <Korean>, <French>, <German>,
<ltalian>, <Japanese>, <Chinese(S)>, <Chinese(T)>,
<Spanish>, <Russian>, <Hungarian>, <Dutch>,
<Polish>, <Portuguese>, <Swedish>, <Thai>,
<Finnish>, <Danish>, <Norwegian>, <Farsi>,
<Afrikaans>, <Basque>, <Catalan>, <Czech>,
<Estonian>, <Greek>, <Hrvatski>, <lcelandic>, <Rumanian>, <Slovak>,
<Slovene>, <Turkish>, <Viethamese>.

3. Tapez sur [~ ] pour sélectionner une langue, ensuite tapez sur [@].
= Vous pouvez voir le texte dans la langue sélectionnée.

7 . . )
fd = On peut modifier les langues prises en charge ou en ajouter d’autres.
REMARQUE
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ENREGISTREMENT VOCAL

Vous permet d’effectuer un enregistrement vocal.

Pour faire un enregistrement vocal

1. Appuyez sur [*9] pendant un court moment pour
vous déplacer vers le menu principal.

Text
Games
Address Book

2. Tapez sur [< >] pour sélectionner <Prime Pack>
(Pack plus), puis tapez sur [@].
= La liste <Prime Pack> (Pack plus) apparait.

3. Tapez sur [~ ] pour sélectionner <Voice REC>
(ENR vocal), puis tapez sur [@].

4, Tapez sur [@].
= Le lecteur commence I'enregistrement.

’g = Vous pouvez effectuer jusqu’a 23 heures d’enregistrement environ
REMARQUE (é 96 kbit/s, 1 GO)

= VVous pouvez stocker un maximum de 999 fichiers d’enregistrement vocal.
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ENREGISTREMENT VOCAL (Suite)

Pour arréter un enregistrement vocal

04:29 PV (il

1. Durant I'enregistrement, tapez sur [@].

= Un message s'affiche vous demandant si vous voulez :;
écouter la lecture du fichier rfécemment enregistré. = |I|| i}
2. Tapez sur [ »] pour sélectionner <Yes> (Oui) ou
<No> (Non), puis tapez sur [@].
= <Yes> (Oui) — le fichier enregistré est lu.
= <No> (Non) — le fichier enregistré n’est pas lu.
= Le fichier enregistré est stocké dans <File Browser>
(Dossier Navigateur) —<Recorded Files> (Fichiers
enregistrés).

- 00:01:15
07:18:05
"»—\ VCE_001.MP3

r,g = Ne placez pas le microphone trop pres ou trop loin de vote bouche car cela
revaroue Produira un enregistrement de mauvaise qualité.

= L’'enregistrement vocal n’est pas optimal lorsque la batterie est trop faible.

= Le nom du fichier d’enregistrement sera spécifié automatiquement, par
exemple, « VCE_000. MP3 ». « VCE » indique un fichier d’enregistrement
vocal et « 000 » désigne le numéro du fichier d’enregistrement.

pour profiter de I'offre prime pack _ 81



JEUX VIDEO

Votre lecteur mp3 inclut déja des jeux palpitants!
= Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.
Q = Tapez sur [ *D] pour vous déplacer vers I'écran précédent.
Appuyez longuement su [ *9] pendant un court moment pour vous déplacer vers le
menu principal.
1. Appuyez sur [ 2] pendant un court moment pour vous
déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Prime Pack> (Pack

REMARQUE

0429 P @@

Text

. Voice REC
plus), puis tapez sur [@].

= La liste <Prime Pack> (Pack plus) apparait. Address Book

3. Tapez sur [~ ] pour sélectionner <Games> (Jeux), puis
tapez sur [@].
= La liste <Games> (Jeux) s’affiche.

4. Tapez sur [~ ] pour sélectionner le jeux souhaité, puis
tapez sur [@].

BOMB BOMB

Ce jeux fait appel a votre cerveau et vous devez modifier I'ordre de
trois blocs pour faire concorder les couleurs de
'image d’'un marteau avec celles des blocs de la pile
en retirant des blocs. Retirez autant de blocs que
possible.

Tapez sur [< »] pour déplacer les blocs sur la
gauche ou sur la droite.

Tapez sur [ ~] pour changer la positions des blocs a
I'horizontale ou a la verticale.

Tapez sur [ ] pour placer le bloc.
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JEUX VIDEO (Suite)
Bubble Smile

Vous tentez d’obtenir un maximum de points en changeant I'ordre de
trois bulles a I'horizontale ou a la diagonale.

Tapez sur [ ~~ < )] déplacer les trois bulles a la
fois.

Tapez sur [@] pour déplacer 'ordre des bulles en
sens horaire.

Tapez sur [ 2] tpour déplacer I'ordre des bulles en
sens antihoraire.

Vous obtenez des points uniquement si vous
réussissez a joindre trois bulles ensemble.

Chicken Runaway

Ce jeux vous laisse déplacer la poule et les poussins en les chassant
sur la droite ou sur la gauche ; vous devez évitez les boules tombant du
ciel pour protéger votre poule aussi longtemps que
possible.

Tapez sur [< »] pour déplacer la poule sur la gauche
ou sur la droite

rg = Les jeux peuvent étre ajoutés ou remplacés sans avis.
RENARQUE " Reportez-vous a la section Help (Aide) pour plus de détails sur la manipulation.
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VISUALISATION DU CARNET D’ADRESSES

Vous pouvez télécharger le carnet d’adresses a I'aide de la fonction Bluetooth afin de
vérifier le numéro de téléphone et appeler directement I'autre personne avec le lecteur.
= Avant de démarrer -En premier lieu, téléchargez le carnet d'adresse d’un périphérique a

I'aide de la fonction de transfert de fichier de Bluetooth. Pour plus de détails, voir la rubrique <Pour

transférer un fichier du périphérique vers le lecteur>. Reportez-vous a la 100.

Vous devez jumeler votre téléphone cellulaire au lecteur avant de pouvoir faire un appel a partir
de la fenétre du carnet d'adresse. Pour plus de détails, voir la rubrique <Pour utiliser un téléphone

cellulaire bluetooth>. Reportez-vous a la 90.
1. Appuyez sur [ 2] pendant un court moment pour vous dépl
principal.
2. Tapez sur [< »] pour sélectionner <Prime Pack> (Pack
plus), puis tapez sur [@].

Text

Voice REC
= La liste <Prime Pack> (Pack plus) apparait. Games
Slecti (AddressBook __ ]
3. Tapez sur [~ ] pour sélectionner <Address Book> AUCTe=SECOKEE =

(Carnet d’adresse), puis tapez sur [@].
= La fenétre du carnet d’adresses apparait.
4. Tapez sur [~ ~] pour sélectionner un nom a vérifier dans la

o

fenétre du carnet d'adresse, puis tapez sur [@].
= Les détails de I'adresse sélectionnée s’affichent.

Pour effectuer un appel a partir du carnet d’

adresses

1. Tapez sur [~ ] pour sélectionner un nom a appeler dans la fenétre

du carnet d'adresse, puis tapez sur [@].
= Les détails de I'adresse sélectionnée s’affichent.

2. Tapez sur [~ ] pour sélectionner le numéro souhaité, puis tapez

sur [@].

= Votre appel est maintenant acheminé a votre correspondant.
= Le carnet d'adresse s’affiche par ordre alphabétique a partir des caracteres

emmque  SPECIauX, des chiffres et ensuite les lettres de I'alphabet.

= Les fichiers transférés sur le lecteur sont sauvegardés dans le dossier <File Browser>

(Explorateur de fichiers) — <Received Files> (Fichiers regus).

= Le carnet d'adresse ne peut acceuillir que les fichiers au format vCard.
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Au moyen d’'un sans fil Bluetooth, vous pouvez établir une connexion sans
fil entre votre lecteur et d’autres périphériques Bluetooth pour échanger des
données, parler mains libres ou écouter de la musique au moyen des écouteurs

stéréo Bluetooth.

fg = Tapez sur [*D] pour vous déplacer vers I'écran précédent.

revaroue  Appuyez sur [*D] pendant un court moment pour vous déplacer vers le menu principal.

QU’EST-CE QUE LE SYSTEME BLUETOOTH?

Bluetooth est une spécification industrielle pour les réseaux radiotéléphoniques zonaux
personnels PAN (wireless personal area networks). Bluetooth vous offre une facon de
vous connecter et d’échanger de I'information entre des appareils comme les téléphones
cellulaires, ordinateurs portatifs, ordinateurs personnels, imprimantes, caméras numériques
et jeux vidéo par le biais d’une fréquence radiophonique sécurisée a faible portée et
globalement sans licence.
Le périphérique Bluetooth peut engendrer du bruit ou créer des dysfonctionnements
en fonction des conditions d’utilisation.
= Brouillage de signal physique — si vous tenez le lecteur en main et portez un casque
stéréo sur la téte par exemple.
= Lorsqu’une partie du corps vient en contact avec le systéme d’émission/réception du
lecteur ou du casque stéréo.
= Variation électrique suite & un brouillage en raison de I'agencement du mur, de l'angle

ou du bureau.
= Interférence électrique provenant d’appareils utilisant la méme bande de fréquences

(ex. : appareils médicaux, fours a micro-ondes et réseaux LAN).
Lorsque vous appariez un dispositif Bluetooth avec le lecteur, assurez-vous de le
faire sur une distance aussi courte que possible.
Plus la distance est grande entre le lecteur et le casque stéréo, pire en est la
qualité. Si la distance excede la limite, les communications sont coupées.
Nous vous conseillons de ne pas d'utiliser les modes de visualisation de texte
ou de photo pendant que vous écoutez de la musique avec le casque stéréo.
Cela peut entrainer la dégradation a la fois de la performance du lecteur et des
communications Bluetooth.
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QU’EST-CE QUE LE SYSTEME BLUETOOTH? (Suite)

= |l peut s’avérer impossible de lire les fichiers de moins que 32 kHz en fonction du
modele de casque stéréo.

= Dans les zones ou la qualité de la réception est pauvre, dans un élévateur ou sous
terre par exemple, la connexion Bluetooth peut mal fonctionner.

= La distance maximale permettant d’établir la connexion sans fil entre le lecteur et
Bluetooth est de 10m. La connexion est automatiquement coupée si la distance
est hors de cette limite. Méme dans ce rayon, la qualité du son peut se dégrader a
cause des obstacles comme les murs ou les portes.

[.g = Réglez le <Bluetooth Mode> (Mode Bluetooth) a <Off> (Arrét) s'il n’est pas utilisé.
Le fait de laisser le <Bluetooth Mode> (Mode Bluetooth) sur <On> (Marche) réduit
le temps utilisable de la pile.

= Les caractéristiques Bluetooth du lecteur sont optimisées pour utilisation avec

les produits Samsung. Les caractéristiques Bluetooth peuvent ne pas fonctionner
correctement si elles sont utilisées avec les produits d’un autre fabricant.

REMARQUE

= Evitez d'utiliser la fonction Bluetooth & des fins illégales (copies piratées, écoutes et
amemon . COmmunications sans fil illégales, etc. a des fins commerciales).
Samsung n’est pas tenu responsable de toute utilisation illégale et de tout résultat
entrainé.
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POUR UTILISER UN CASQUE STEREO BLUETOOTH

Vous pouvez utiliser un casque stéréo Bluetooth pour apprécier une musique
stéréo de haute qualité, tout ¢a sans aucun fil !

= Avant de démarrer — Si votre lecteur est déja connecté a un téléphone cellulaire ou
a un périphérique Bluetooth, coupez la connexion en premier lieu.
Assurez-vous que I'appareil Bluetooth a connecter est paramétré pour un
appariement. (reportez-vous au manuel d’utilisation de I'appareil)

Pour enregistrer un casque stéréo Bluetooth

(vous devez I'enregistrer une seule fois)

1. Appuyez sur [*] pendant un court moment pour
vous déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Bluetooth>,
puis tapez sur [@].
= Le <Bluetooth Mode> (Mode Bluetooth) est réglé sur <On> (Activé).
= Licone @ s'illumine.

3. Paramétrez le casque stéréo pour I'appariement.
= Reportez-vous au guide d’utilisation du casque pour

préparer ce dernier a s’apparier au lecteur.

4. Tapez sur [~ ] pour sélectionner <Stereo Headset> (Ecouteurs

Stéréo), puis tapez sur [@].

= Le message <Search New Device> (Rech. nv périph) s'affiche, si un périphérique
a été déja appareillé avec le lecteur. Sélectionnez <Search New Device> (Rech.
nv périph) pour rechercher un nouveau périphérique a appareiller.

= Le casque a enregistrer est sur la liste.
5. Tapez sur [~ ] pour sélectionner un nom d’écouteurs, ensuite

tapez sur [@].

= La fenétre de saisie du mot de passe s'affiche si le mot de passe des
écouteurs est autre que 0000. Reportez-vous au manuel d'utilisation des
écouteurs pour en savoir plus sur le mot de passe.

= L'enregistrement du casque est terminé.
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POUR UTILISER UN CASQUE STEREO BLUETOOTH
(Suite)

Pour enregistrer un casque stéréo Bluetooth (Suite)

'.g = VVous ne pouvez utiliser la fonction Bluetooth que lorsque vous écoutez de
remarque la musique ou visionnez un fichier vidéo. Elle n’est pas accueillie lorsque
vous écoutez la radio FM.

= Description de I'icone Bluetooth
3 : Mode Bluetooth activé {3 : Raccordé a un casque stéréo
Ed3 : Raccordé a un téléphone cellulaire

= Pour désactiver le fonction Bluetooth, réglez le mode Bluetooth dans
<Bluetooth> (Bluetooth) — <Bluetooth Mode> (Mode Bluetooth) — <Off>
(Désactivé).

= Ecouteurs conformes a Bluetooth

Fabricant Modéle Fabricant Modele

i.TECH Blueband SAMSUNG SBH100
Plantronics |PULSAR 590A Jabra BT620s
MOTOROLA HT820

= Utilisez uniqguement les casques stéréo certifiés Bluetooth. Les trousses
piéton mono ne sont pas pris en charge.

= Réglez le <Bluetooth Mode> (Mode Bluetooth) a <Off> (Désactivé) s'il n’est
pas utilisé. Le fait de laisser le <Bluetooth Mode> (Mode Bluetooth) sur
<On> (Activé) réduit le temps utilisable de la pile.
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POUR UTILISER UN CASQUE STEREO BLUETOOTH
(Suite)

Pour établir la connexion avec un casque stéréo
Bluetooth enregistré

1. Tapez sur [~ ] pour sélectionner <Stereo
Headset> (Ecouteurs stéréo) a I'écran Bluetooth, | :
ensuite tapez sur [@].

Mobile Phone

2. Tapez sur [~ ] pour sélectionner des écouteurs | File Transfer
Bluetooth Mode

stéréo, ensuite tapez sur [@]. Eiiipolh Seftings

L'icéne fﬁ_ﬂ\ s’affiche a I'écran lorsque la connexion est
établie.
= Vous pouvez connecter jusqu’a 2 casques.

3. Ecoutez la musique.
= Vous pouvez écouter de la musique a l'aide du casque stéréo.

'Q = Si vous ne trouvez pas le casque que vous souhaitez utiliser, procédez tout
remarQUE  d’abord a son enregistrement.

= Si vous éteignez puis allumez le lecteur ou le casque en I'espace d’'une
seconde, la communication Bluetooth est interrompue.
Si vous souhaitez écouter de la musique a 'aide du casque stéréo, répétez
les instructions ci-dessus.

= Lorsque deux casques sont connectés, seul le premier peut étre activé
pour I'opération des fonctions comme lecture/arrét et réglage du volume.
Reportez-vous au guide d'utilisation du casque pour plus de détails.
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POUR UTILISER UN TELEPHONE CELLULAIRE BLUETOOTH

Vous pourrez faire ou recevoir des appels téléphoniques sur votre lecteur

une fois que vous y brancherez un téléphone cellulaire Bluetooth. Le lecteur

fonctionnera comme dispositif mains libres.

= Avant de commencer - Si votre lecteur est déja branché a des écouteurs stéréo
Bluetooth ou a un périphérique, coupez la connexion en premier
lieu. Assurez-vous que le téléphone cellulaire Bluetooth a
connecter est paramétré pour un appariement. .
(reportez-vous au manuel d'utilisation de I'appareil). A partir
de <Bluetooth Settings> (Parameétres Bluetooth) — <Discover
Option> (Options du mode “découverte”), réglez & <Discoverable>
(Décelable). Reportez-vous a la page 102.

Pour enregistrer le téléphone cellulaire Bluetooth
(vous devez I'enregistrer une seule fois)

1. Appuyez sur [*9] pendant un court moment pour T o
vous déplacer vers le menu principal. i
z . St Headset
2. Tapez sur [< 5] pour sélectionner <Bluetooth>, | rErees s
puis tapez sur [@]. File Transfer

Bluetooth Mode

= Le <Bluetooth Mode> (Mode Bluetooth) est réglé sur <On> (Activé). Blueigolh Setings

= Licone @ s'illumine. :

3. Recherchez YP-T10 dans le menu du téléphone |
cellulaire. >
= Sivous avez renommé le lecteur YP-T10 recherchez

Cce nouveau nom.

4. Lorsque la fenétre de saisie du mot de passe s’affiche sur le
téléphone cellulaire, entrez-le.

5. Lorsque le lecteur affiche <Connect?> (Se Connecter ?), tapez sur
[< »] et sélectionnez <Yes> (Oui), puis appuyez ensuite sur [@].
= La fenétre de saisie du code NIP (mot de passe) s'affiche.

=i =

r,g = Les caractéres du mot de passe peuvent varier en fonction du téléphone
rewarque  Cellulaire utilisé. (reportez-vous au manuel d'utilisation de I'appareil)
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POUR UTILISER UN TELEPHONE CELLULAIRE
BLUETOOTH (SUITE)

Pour enregistrer le téléphone cellulaire Bluetooth (Suite)

6. Utilisez les fleches [ ~~ ¢ »] et la touche [@]
pour saisir le mot de passe de I'appareil cellulaire
a ajouter au lecteur.
= Assurez-vous d’entrer le méme mot de passe qu'a
I'étape 4 ci-dessus.

7. Utilisez les fleches [ ~ ~ ¢ »] pour vous déplacer
sur <OK>, puis tapez sur [@].

= L'enregistrement du téléphone cellulaire est terminé.

’g = Pour certains types de téléphones cellulaires, la fonction de recherche d’appareil et
revarque  d'appel cellulaire peut ne pas fonctionner correctement.

= Sj vous appuyez sur une touche du téléphone cellulaire, faites ou terminez un
appel par connexion Bluetooth entre le lecteur et le téléphone cellulaire, le lecteur
pourra produire du bruit.

= Nous vous recommandons d'utiliser un nom d'appareil en anglais pour un
téléphone cellulaire.

= Téléphones cellulaires conformes a la norme Bluetooth

Fabricant Modele
SAMSUNG SPH-C3250, SPH-W2700, SPH-V7400, SPH-V6900, SCH-W270,
SPH-B5600, SPH-B3200, SGH-X828, SGH-1718, SGH-E908, SGH-U608
LG LG-KH1000, LG-KV2400, LG-KG90, LG-KG77
SKY IM-U130
NOKIA N72
PHILIPS S900
MOTOROLA Z3
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POUR UTILISER UN TELEPHONE CELLULAIRE
BLUETOOTH (SUITE)

Pour se brancher au téléphone mobile enregistré

Bluetooth

1. Tapez sur [~ ] a I'écran Bluetooth pour - ez o
sélectionner <Mobile Phone> (Téléphone ]
cellulaire), puis tapez sur [@].
= Le menu Téléphone cellulaire apparait. Call by Number

2. Tapez sur [~ ] pour sélectionner <Connect to £ Hisiony
Mobile Phone> (Etablir la communication), puis
tapez sur [@].

3. Tapez sur [~ ] pour sélectionner un téléphone
cellulaire, puis tapez sur [@].
= L'icone Edy s'affiche a I'écran lorsque la connexion est établie.

Q = Si vous ne décelez pas I'appareil a connecter, veuillez I'enregistrer sur le
rewarque l€CtEUr en premier lieu. Reportez-vous a la page 90.

= La connexion du téléphone cellulaire pourrait étre coupée si vous éteignez
et rallumez le lecteur. Si la connexion est coupée, reportez-vous aux
étapes précédentes pour vous reconnecter.

Pour signaler le dernier numéro utilisé

1. Tapez sur [~ ] a I'écran Bluetooth pour
sélectionner <Mobile Phone> (Téléphone

cellulaire), puis tapez sur [@]. Connect to Mobile Phone
= Le menu Téléphone cellulaire apparait.
. X Call by Number
2. Tapez sur [~ ~] pour sélectionner <Redial> Call History

(Recomposer), puis tapez sur [@].
= Votre appel est maintenant acheminé vers le dernier
nuUMEro composé.

= En fonction de votre modeéle, le journal des appels
récents apparait. Sélectionnez le dernier numéro sur la liste du journal.
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POUR UTILISER UN TELEPHONE CELLULAIRE

BLUETOOTH (SUITE)

Pour faire un appel a I'aide du lecteur

1. Tapez sur [~ ~] a I'écran Bluetooth pour
sélectionner <Mobile Phone> (Téléphone
cellulaire), puis tapez sur [@].

= Le menu Téléphone cellulaire apparait.

2. Tapez sur [~ ] pour sélectionner <Call by
Number> (Appel par numéro), puis tapez sur [@].
= La fenétre de saisie du numéro apparait.

3. Utilisez les fleches [~ ~ ¢ »] et la touche [@]
pour saisir le numéro a composer.

Connect to Mobile Phone
Redial

Call by Number =,

Call History

o i

4. Utilisez les fleches [ ~ ~ < »] pour vous déplacer sur <€ J>, puis

tapez sur [@].

= Votre appel est maintenant acheminé a votre correspondant.

fg = Sj le téléphone cellulaire possede un numéro abrégé, vous pouvez le
rewaroue  COmposer directement en maintenant la touche du dernier numéro enfoncée.

Pour mettre fin a un appel

Tapez sur[ < > ] pour vous déplacer sur <(_& J> , puis tapez sur [@].

= L'appel est terminé.
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POUR UTILISER UN TELEPHONE CELLULAIRE
BLUETOOTH (SUITE)

Pour faire un appel a I'aide du répertoire téléphonique

1. Tapez sur [~ ~] a I'écran Bluetooth pour
sélectionner <Mobile Phone> (Téléphone

cellulaire), puis tapez sur [@]. 'EZZT:ICHO Mobile Phone

= Le menu Téléphone cellulaire apparait. o) lomcer

2. Tapez sur [~ ] pour sélectionner <Call
History> (Journal des appels), puis tapez sur [@].

= Le répertoire téléphonique apparait.

]

3. Tapez sur [~ ~] pour sélectionner le numéro
souhaité, puis tapez sur [@].

= Votre appel est maintenant acheminé a votre correspondant.

Pour supprimer un numéro du répertoire téléphonique

1. Tapez sur [~ ] dans <Call History> (Journal des appels) pour
supprimer un numéro, puis tapez sur [@].

2. Tapez sur [~ ] pour sélectionner <Delete> (Supprimer), puis tapez

sur [@].

= Sivous souhaitez supprimer tous les numéros du répertoire, sélectionnez
<Delete All> (Supprimer tout).
= La fenétre de confirmation apparait.

3. Tapez sur [< ] pour sélectionner <Yes> (Oui), puis tapez sur [@].
= Le numéro sélectionné est supprimé.
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POUR UTILISER UN TELEPHONE CELLULAIRE
BLUETOOTH (SUITE)

Pour répondre au téléphone

1. Lorsque vous recevez un appel, <Connect?> (Se Connecter ?)
s'affiche.

2. Tapez sur [< >] pour sélectionner <Yes> (Oui), puis tapez sur [@].

= Débutez la conversation.

Pour revenir au téléphone mobile pendant que vous
parlez a mains libres lecteur (YP-T10)

Tout en parlant sur le lecteur, tapez sur [< ] pour sélectionner < Q>puis
tapez sur [@].
= Vous pouvez maintenant parler sur le téléphone cellulaire.

Pour revenir au lecteur (YP-T10) pendant que vous étes
au téléphone mobile

Tout en parlant sur le téléphone cellulaire, tapez sur [< >] pour
sélectionner <Q>pws tapez sur [@].
= Vous pouvez maintenant parler sur I'appareil a mains libres.

Pour régler le volume

Tout en parlant sur le mains libres, tapez sur [~ ~] pour régler le volume.
= Vous pouvez sélectionner l'intensité du volume entre 0 et 30.

g = Vous ne pouvez pas prendre d’appel a I'aide du mains libres (YP-T10) en

revarque  COUTS d'enregistrement.
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POUR TRANSFERER DES FICHIERS VERS/D’UN

PERIPHERIQUE BLUETOOTH

Vous pouvez transférer des fichiers de musique, d'images et de vidéos a partir
de périphériques conformes a Bluetooth (lecteur MP3, téléphone mobile, etc.)

vers le lecteur ou inversement.

= Avant de démarrer — Si votre lecteur est déja connecté a un téléphone cellulaire ou a

un casque stéréo Bluetooth, coupez la connexion en premier lieu.

Assurez-vous que le périphérique Bluetooth a brancher est paramétré pour un
appariement. (reportez-vous au manuel d'utilisation de I'appareil)
Vérifiez si I'appareil Bluetooth peut accueillir la fonction de transfert de fichier.

(reportez-vous au manuel d'utilisation de I'appareil)

Pour enregistrer un périphérique sur le lecteur

(vous devez I'enregistrer une seule fois)

1. Appuyez sur [ 2] pendant un court moment pour
vous déplacer vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Bluetooth>,
puis tapez sur [@].
= Le <Bluetooth Mode> (Mode Bluetooth) est réglé sur

<On> (Marche).

= L'icone @ s'illumine.

3. Paramétrez le périphérique pour I'appariement.
= Reportez-vous au manuel d'utilisation du périphérique

Stereo Headset

File Transfer =3

Bluetooth Mode
Bluetooth Settings

= alied =

pour plus de renseignements concernant la préparation du périphérique pour

I'appariement.

4. Tapez sur [~ ~] pour sélectionner <File Transfer> (Transfert de

Fichiers), puis tapez sur [@].
= Le périphérique a enregistrer figure sur la liste.

= Le message <Search New Device> (Rech. nv périph) s'affiche, si un périphérique
a été déja appareillé avec le lecteur. Sélectionnez <Search New Device> (Rech.
nv périph) pour rechercher un nouveau périphérique a appareiller.
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POUR TRANSFERER DES FICHIERS VERS/D’UN
PERIPHERIQUE BLUETOQOTH (Suite)

Pour enregistrer un périphérique sur le lecteur (suite)

5. Tapez [~ ] pour sélectionner le périphérique, - preerer
ansfer

puis tapez [@].

= La fenétre du code NIP (mot de passe) apparait si le mot
de passe du périphérique est autre que 0000. Voir le
manuel du périphérique pour le mot de passe.

6. Entrez le mot de passe lorsque la fenétre de
saisie s'affiche sur le périphérique.

|| Searching (0)

= Assurez-vous d’entrer le méme mot de passe qu'a I'étape
5 plus haut.

= Lorsque vous aurez terminé le jumelage, vous pourrez voir I'écran de transfert
de fichiers.

= Voir I'étape 3 a la page 98 concernant le transfert de fichiers du lecteur vers un
périphérique.
£/] = Les caractéres du mot de passe peuvent varier en fonction du périphérique
revaroue  Utilisé. (Reportez-vous au manuel d'utilisation de I'appareil)

= Certaines fonctions peuvent ne pas fonctionner correctement si vous
utilisez un périphérique Bluetooth autre que le YP-T10 pour transférer des
fichiers.
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POUR TRANSFERER DES FICHIERS VERS/D’UN
PERIPHERIQUE BLUETOQOTH (Suite)

Pour transférer un fichier du lecteur vers le périphérique

= Avant de commencer - Si vous ne décelez pas le périphérique a connecter,
veuillez I'enregistrer sur le lecteur en premier lieu. Reportez-vous a la page 96.
Assurez-vous que le périphérique Bluetooth a brancher est paramétré pour un
appariement. (reportez-vous au manuel d'utilisation de I'appareil)

1. A I'écran Bluetooth, tapez [~ ] pour
sélectionner <File Transfer> (Transfert de el
Fichiers) puis tapez [@].

M Playlists

2. Tapez [~ v] pour sélectionner le périphérique & | mvee

connecter, puis tapez [@]. M Datacasts

., . - I Texts
= Lorsque vous aurez terminé la connexion, vous pourrez L

voir I'écran de transfert de fichiers. | am Received Files

Bieo o

3. Tapez [~ ~] pour sélectionner le dossier
souhaité, puis tapez [@]. Ex :) lécran <File

- . . .. . Transfer> (Transfert de
4. Tapez [~ ~] pour sélectionner le fichier souhaité, gicpiers) d(u lecteur

puis tapez [@].
= Le fichier sélectionné est transféré vers le périphérique.

= Lorsque le transfert est terminé, tapez I'icbne [ *D] pour quitter le mode de
remarque  transfert. Reportez-vous a la page 99.
= Ce lecteur ne lit pas les fichiers de gestion des droits numériques DRM
(chargeables).
= Si vous éteignez et rallumez le lecteur ou le périphérique, la connexion
pourrait étre coupée. Si la connexion est coupée, reportez-vous aux étapes
précédentes pour vous reconnecter.
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POUR TRANSFERER DES FICHIERS VERS/D’'UN
PERIPHERIQUE BLUETOQOTH (Suite)

Pour annuler le transfert du fichier

Tapez [@] durant le transfert.
= Le transfert du fichier s’interrompt.

Pour quitter le mode de transfert

1. Appuyez longuement sur [*2] a I'écran Liste des fichiers.

= Chaque fois que vous tapez [ *D], vous vous déplacez sur I'écran précédent et
vous quittez la fenétre de transfert.

2. Tapez [¢ »] pour sélectionner <Yes> (Oui), puis tapez [@].

= Vous quittez le mode de transfert de fichiers.
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POUR TRANSFERER DES FICHIERS VERS/D’UN
PERIPHERIQUE BLUETOQOTH (Suite)

Pour transférer un fichier du périphérique vers le
lecteur

Si vous souhaitez transférer un fichier externe sur le lecteur, préparez le
fichier pour un jumelage.

= Avant de démarrer - Si vous ne décelez pas le périphérique a connecter,
veuillez I'enregistrer sur le lecteur en premier lieu.
Assurez-vous que le périphérique Bluetooth a brancher est paramétré pour
un appariement. (reportez-vous au manuel d'utilisation de I'appareil)
Vérifiez si I'appareil Bluetooth peut accueillir la fonction de transfert de
fichier.
(reportez-vous au manuel d'utilisation de I'appareil)
A partir de <Bluetooth Settings> (Paramétres Bluetooth) — <Discover
Option> (Options du mode “découverte”), réglez a <Discoverable>
(Décelable). Reportez-vous a la page 102.

1. Appuyez sur [ o] pendant un court moment pour vous déplacer
vers le menu principal.

2. Tapez sur [< >] pour sélectionner <Bluetooth>, puis tapez sur [@].

= Le <Bluetooth Mode> (Mode Bluetooth) est réglé sur <On> (Marche).

= L'icone @ s'illumine.

= Vous pouvez alors transférer un fichier du périphérique vers le lecteur.

= Pour jumeler le périphérique et le transférer sur le lecteur, reportez-vous au
guide d'utilisation de I'appareil.

= Les fichiers transférés sur le lecteur sont enregistrés dans le dossier <File
Browser> (Dossier Navigateur) — <Received Files> (Fichiers recus).
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POUR UTILISER LE MENU BLUETOOTH

Pour déconnecter le dispositif Bluetooth

1. Dans la fenétre Bluetooth, tapez sur [@].

2. Tapez sur [~ ] pour sélectionner <Disconnect> | connected Device

(Déconnecté), puis tapez sur [@].

= La fenétre de confirmation de coupure de la connexion
apparait.

3. Tapez sur [€ >] pour sélectionner <Yes> (Oui),
puis tapez sur [@].

= Le périphérique actuellement connecté est
déconnecté.

Pour vérifier le dispositif Bluetooth connecté

1. Dans la fenétre Bluetooth, tapez sur [@].
" Disconnect

Connected Device

2. Tapez sur [~ ] pour sélectionner <Connected
Device> (Périph. Connecté), puis tapez sur [@].

= Vous verrez les renseignements relatifs au
périphérique connecté.

Q = Vous pouvez déconnecter ou Vvérifier le périphérique uniquement lors de la
connexion d’un casque stéréo Bluetooth ou d’un téléphone cellulaire.
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PARAMETRES BLUETOOTH

= Avant de démarrer - Réglez <Bluetooth Mode> (Mode Bluetooth) sur <On>
(Activé).

1. Appuyez sur [*2] pendant un court moment pour vous
déplacer vers le menu principal.

>, S
~— Bluetooth
Stereo Headset
2. Tapez sur [< >] pour sélectionner <Bluetooth>, puis tapez| Mobile Phone

File Transfer
sur [@]. Bluetooth Mode

3. Tapez sur [~ v] pour sélectionner <Bluetooth Settings> [N
(Parameétres Bluetooth), puis tapez sur [@]. :
= Le menu <Bluetooth Settings> (Parametres Bluetooth) apparait. g

o

4. Réglez ces fonctions a I'aide des touches [~ v] et [@].

Options de réglage de Bluetooth

= Discover Option (Options du mode “découverte”) : Vous pouvez paramétrer le
périphérique Bluetooth pour détecter ce lecteur. L'option <Discoverable> (Décelable)
regle le périphérique pour détecter et I'option <Non-Discoverable> (Non Décelable)
désactive la détection.

= Search Timeout (Délai d’Attente Recherche Dépassé) : vous permet de sélectionner
le temps de recherche d'un nouvel appareil. Suite au réglage d’'une période de temps,
I'appareil recherchera les nouveaux dispositifs pendant la période limitée que vous aurez
réglée. Sélectionnez parmi <10 sec>, <20 sec>, <30 sec>, <45 sec> ou <60 sec>.

= Delete Device (Supprimer le Périphérique) : Vous permet de supprimer un appareil
enregistré sur le lecteur. Reportez-vous a la page 103.
Sélectionnez <Delete All> (Supprimer Tous) pour supprimer tous les périphériques
enregistrés.

= My Device Info (Informations de Mon Périphérique) : Vous pouvez vérifier le nom et
I'adresse de votre lecteur.
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PARAMETRES BLUETOOTH (Suite)

Pour supprimer un dispositif Bluetooth

1. Tapez sur [~ ] pour sélectionner <Delete Device>
(Supprimer le Périphérique), puis tapez sur [@].
= Vous verrez la liste des dispositifs enregistrés.
2. Tapez sur [~ ] pour sélectionner un périphérique a
supprimer, ensuite tapez sur [@].
= Pour supprimer tous les périphériques enregistrés,
sélectionnez <Delete All> (Supprimer Tous).

3. Tapez sur [ >] pour sélectionner <Yes> (Oui), puis

tapez sur [@].
= Le périphérique sélectionné est supprimé.

Pour renommer un dispositif Bluetooth

 ocazsPm@m
.? B £ﬁ(ﬁsemngs
Discover Option
Search Timeout

Delete Device 5

My Device Info.

1. Tapez sur [~ ] pour sélectionner <My Device Info>
(Informations de Mon Périphérique), puis tapez sur [@].
2. Tapez sur [@].
= |’écran Informations de Mon Périphérique apparait.
3. Tapez sur [~ ] pour sélectionner <Edit Device Name>
(Modifier le nom du périphérique), puis tapez sur [@].
= La fenétre Edit Device Name (Modifier le nom du
périphérique) apparait.
4. Renommer le périphérique a I'aide des touches
[~ <] et[@].
= [B] : Le mode d’entrée bascule des numéros aux
majuscules anglaises et aux minuscules anglaises.

= [[=]1 : Vous pouvez supprimer les caractéres un par un.
= [[oK ] : Vous pouvez ajouter un espace entre les caractéres.

= EX. : pour saisir “YPS5”
- Déplacez vous sur I'icdne de I'autre touche et tapez-la.

@ (une fois) » m(S fois) » E(une fois) » m(a fois) ® [ (deux fois) »

B(une fois)
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Si vous rencontrez un probleme avec votre lecteur MP3, trouvez une
solution sur cette liste. Si le probleme persiste, contactez le centre de
service a la clientele Samsung le plus proche.

PROBLEME

SOLUTION

L'appareil ne s’allume
pas.

L'appareil ne s’allume pas si la pile est complétement
a plat. Rechargez la pile et remettez I'appareil sous
tension.

Appuyez sur la touche Reset (Réinitialisation).

Les touches ne
fonctionnent pas.

Veérifiez si l'interrupteur \T_wois 7/ est dirigé
dans le sens de la fleche.

Confirmez que vous avez appuyé sur la bonne
touche, puis essayez a nouveau.

Appuyez sur la touche Reset (Réinitialisation).

L’écran ne s’allume
pas.

Il se peut que les données affichées a I'écran ne
soient pas visibles sous les rayons directs du soleil.

Si vous sélectionnez <Display Off> (Ecran désactivé)
du menu <Settings> (Réglages) — <Display>
(Afficher), I'écran demeure éteint. Tapez sur une
touche pour voir s'il s’allume.

104 _ dépannage



PROBLEME

SOLUTION

L'alimentation est
coupée.

Vérifiez I'état de la pile.

L'alimentation se coupe automatiquement lorsque la
pile est complétement a plat. Rechargez la pile.

Si vous sélectionnez <Auto Power Off> (Mise hors
tension automatique) dans <Settings> (Parametres)
— <System> (Systeme), le lecteur s’éteint lorsqu’il
est en mode Pause. Allumez le lecteur.

La durée de vie de

la batterie differe de
celle indiquée dans le
manuel.

La durée de la pile peut varier en fonction du mode
sonore et des réglages de I'écran.

La durée de la pile peut étre réduite si vous exposez
I'appareil a des températures basses ou élevées
pendant des périodes prolongées.

Défaillance du
programme Media
Studio

Confirmez que votre ordinateur possede les
caractéristiques fondamentales.

La connexion a
I'ordinateur est
désactivée.

Vérifiez si la fiche USB est bien branchée et
réessayez.

Cliquez sur le bouton <Start> (Démarrer) de la

barre d’outils de votre ordinateur pour lancer la

mise a jour de Windows. Sélectionnez les mises a
jour principales et les ensembles de modifications
provisoires (Service Packs), puis mettez tout a jour.
Redémarrez votre ordinateur et rebranchez I'appareil.

Le transfert de
fichier s’effectue trop
lentement.

Le transfert est plus lent si votre ordinateur exécute
simultanément plusieurs programmes incluant <Media
Studio>. Quittez les programmes inutiles et essayez a
nouveau.
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PROBLEME

SOLUTION

Le lecteur n’effectue
pas la lecture.

Vérifiez que le fichier disponible a bien été enregistré
dans la mémoire.

Assurez-vous que le fichier musical n’est pas endommagé.
Vérifiez que la puissance de la batterie est suffisante.

Le téléchargement de
fichiers ne fonctionne
pas.

Assurez-vous que le cable USB est bien branché.
Rebranchez si nécessaire.

Assurez-vous qu'il reste de I'espace disponible sur la
mémoire.

Appuyez sur la touche Reset (Réinitialisation).

Des fichiers ou des
données manquent.

Vérifiez si le cable USB a été débranché durant

le transfert du fichier ou des données. Si tel est le
cas, les fichiers/données mais également 'appareil
risquent d'étre endommageés. Vous devez faire preuve
d’'une extréme prudence a cet égard car Samsung

ne saurait en aucun cas étre tenu responsable de la
perte des données.

Affichage anormal de la
durée de lecture.

Confirmez que le fichier est au format VBR (débit binaire
variable).

L'appareil est chaud.

Les phases de chargement peuvent générer de la
chaleur. Cela n'a aucune incidence sur la durée de
vie de I'appareil ou sur son fonctionnement.

Un message apparait
pendant que vous
visionnez une vidéo.

Tentez de télécharger le clip vidéo a nouveau avec
Media Studio.
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PROBLEME

SOLUTION

La connexion Bluetooth
n'a pu étre établie.

Vérifiez si le casque stéréo est certifié Bluetooth.
Les casques mains libres monophoniques ne sont
pas accueillis.

La connexion Bluetooth peut se désactivez si vous
éteignez et allumez le lecteur ou le casque stéréo.
Dans ce cas, tentez une nouvelle connexion.

Si vous souhaitez utiliser votre téléphone cellulaire,
assurez-vous d’avoir désactivé la connexion
Bluetooth entre le lecteur et le casque stéréo

Si vous souhaitez utiliser votre téléphone mobile,
assurez-vous d’'avoir réglé le lecteur comme suit :
<Bluetooth Settings> (Parametres Bluetooth) —
<Discover Option> (Options du mode “découverte”)
— <Discoverable> (Décelable).

S'il est réglé sur <Non-Discoverable> (Non
Décelable), votre téléphone cellulaire ne décéle pas
le lecteur.
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dNrnexe

ARBRE INVERSE DU MENU

Voici un coup d’oeil rapide sur la répartition des menus et des fonctions de votre
nouveau lecteur MP3.

Ecran de sélection du menu

. . ; FM Prime File .
Music Videos Pictures Radio Datacasts Pack B Bluetooth ~ Settings
Stereo
Text Headset Menu Style
Voice REC Mobile Phone Sound
Games File Transfer Display
Bluetooth
Alarm Mode Language
Bluetooth |
Settings Date&Time
System
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CARACTERISTIQUES DU PRODUIT

Nom du modele

YP-T10

Caractéristiques nominales

5,0 Vcc / 500 mA

Alimentation de la
batterie intégrée

550 mAh /3,7 Vcc

Fichier Compatibilité

AUDIO : MPEG1/2/2,5, couche 3 (8 kb/s a 320 kb/s, 22

VIDEO :

Image :

kHz a 48 kHz),

WMA (8 kbit/s a 320 kbit/s, 8 kHz a 48 kHz),
AAC-LC (16 kbit/s a 256 kbit/s, 8 kHz a 48 kHz)
AAC-Plus (16 kbit/s & 256 kbit/s, 16 kHz & 44,1
kHz), Enhanced-AAC-Plus (16 kbit/s & 56 kbit/s,

32 kHz a 44,1 kHz)
SVI (Vidéo : MPEGA4,

Audio : MP3 (stéréo 44,1 kHz 16 bits, 128 kb/s),

WMV (Vidéo : WMV profil simple,
Audio :WMA (Max. 860 kb/s),
Résolution : 320x240,

Vitesse de défilement : environ 9 metres par

seconde (30 pils)

JPEG (ISO/IEC 10918-1/Annexe F — Mode
de fonctionnement séquentiel DCT)

Sortie des écouteurs

20 mW/canal. (sur 16 Q)

Bande de fréquences de
la sortie

20Hz~20KHz

Rapport signal sur bruit

90 dB avec FPB de 20 kHz (fondé sur 1 kHz - 0 dB)

Durée de lecture

Maximum de 30 heures de musique (fondé sur :
MP3 128 kb/s, volume 15, mode de son normal),
Maximum de 4 heures de lecture vidéo

Plage de températures de
fonctionnement

-5~35°C (23-95°F)
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Etui Plastique , Aluminium

Poids 439

Dimensions (L x H x P) 41,5 X 96 X 7,9 mm

Fréquence FM| 87,5~108,0MHz| T.H.D. FM 1%

Radio FM

Rapport signal Sensibilité
FM 50dB FM utile 30dBy
Systémes sans fil
Type d’émission F1D
Puissance RF 1,8mwW
Fréquence d’émission 2402 MHz a 2480 MHz
Fréquence de réception 2402 MHz a 2480 MHz
Nombre de canaux 79 canaux
Température -10 °C~ +50°C(14 ~ 122°F)

Systeme de modulation GFSK

Mode de communication Opération bidirectionnelle a 'alternat

Humidité 95%
Version prise en charge 2,0
Module BTEM48B2SA

Le contenu de ce manuel est susceptible d’étre modifié en vue d’étre amélioré
sans notification préalable.

Cet appareil numérique de la classe B est conforme a la norme NMB-003 du
Canada.
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LICENCE

L'unité qui se trouve avec ce manuel de I'utilisateur est fournie sous licence
sous certains droits de propriété intellectuelle de parties tierces. Cette licence
est limitée a une utilisation privée non commerciale par I'utilisateur final pour les
contenus sous licence.

Aucun droit n’est concédé pour une utilisation commerciale.

Cette licence ne couvre aucun produit autre que celui-ci et ne peut étre étendue
a un produit ou processus qui n'est pas sous licence selon la norme ISO/IEC
11172-3 ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.

La licence couvre uniqguement I'utilisation de ce produit pour encoder et/ou
décoder des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des
fonctions du produit qui ne sont pas conformes a la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3.
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Garantie Limitée Samsung

Samsung Electronics Canada Inc. (SECA)
garantit ce produit contre tout défaut de fabrication.

SECA garantit aussi que si cet appareil ne fonctionne pas convenablement durant la
période de garantie et qu'il s’agit d’'un défaut de fabrication SECA se réservera le droit
de réparer ou de remplacer I'appareil défectueux

Toutes les réparations sous garantie doivent étre effectuées par un Centre de service
autorisé SECA. Le nom et I'adresse du Centre de service le plus prés de chez vous
peut étre obtenu en composant sans frais le 1-800-726-7864 ou en visitant notre site
web au www.samsung.ca

Main-d’oeuvre Piéces

un (1) an (au comptoir) un (1) an

Pour tous les modeles portatifs, le transport de I'appareil sera la responsabilité du
client. Le recu de vente original doit étre conservé par le client car cela constitue sa
seule preuve d'achat acceptée. Il doit le présenter au Centre de service agréé au
moment ou il fait la demande d’une réparation sous garantie.

Exclusions

Cette garantie ne couvre pas les dommages causés par un accident, un incendie, une
inondation, un cas de force majeure, un mauvais usage ou une tension incorrecte. La
garantie ne couvre pas aussi une mauvaise installation, une mauvaise réparation, une
réparation non autorisée et tout usage commercial ou dommages survenus durant le
transport. Le fini extérieur et intérieur de méme que les lampes ne sont pas couverts
par cette garantie. Les ajustements par le client qui sont expliqués dans le guide

de l'utilisateur ne sont pas couverts en vertu de cette garantie. Cette garantie sera
automatiquement annulée pour tout appareil qui aurait un numéro de série manquant
ou modifié. Cette garantie est valable seulement sur les appareils achetés et utilisés
au Canada.




Si vous avez des suggestions ou des questions concernant les
produits Samsung,
veuillez contacter le Service Consommateurs Samsung.

Samsung Electronique Canada Inc., Service a la Clientéle
1-800-SAMSUNG (7267864)
www.samsung.com/ca
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